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Preface FIX ME!

This preface includes the following sections:

• What’s New in This Release

• About This Guide

• Customer Support

This guide contains installation instructions for four releases of 
Synopsys tools—versions T-2002.12,  T-2002.09, 2002.05, and 
2002.03. The version T-2002.09,  2002.05, and 2002.03 instructions 
in this guide are also the basis for quality releases. For the latest 
product-specific installation information for quality releases, see the 
product release notes.

Important:   
Install each version of the software in a new directory. Do not 
install different versions of Synopsys software in the same 
directory. 
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What’s New in This Release

For information about new features and changes in specific 
Synopsys tools, see the individual product documentation. For links 
to Synopsys documentation, see “Related Publications” in the next 
section.

About This Guide

The Installation Guide provides the basic information and 
procedures required to install Synopsys tools.

Audience

This guide is written for system administrators responsible for 
installing Synopsys software tools.

Related Publications

For additional information about Synopsys tools, see

• Synopsys Online Documentation (SOLD), which is included with 
the software for CD users or is available to download through the 
Synopsys Electronic Software Transfer (EST) system

• Documentation on the Web, which is available through SolvNet 
at http://solvnet.synopsys.com

• The Synopsys MediaDocs Shop, from which you can order 
printed copies of Synopsys documents, at 
http://mediadocs.synopsys.com
xx
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Conventions

The following conventions are used in Synopsys documentation.

Convention Description

Courier Indicates command syntax.

Courier italic Indicates a user-defined value in Synopsys 
syntax, such as object_name. (A user-defined 
value that is not Synopsys syntax, such as a 
user-defined value in a Verilog or VHDL 
statement, is indicated by regular text font 
italic.)

Courier bold Indicates user input—text you type verbatim—
in Synopsys syntax and examples. (User input 
that is not Synopsys syntax, such as a user 
name or password you enter in a GUI, is 
indicated by regular text font bold.)

[ ] Denotes optional parameters, such as 
pin1 [pin2 ... pinN]

| Indicates a choice among alternatives, such as 
low | medium | high
(This example indicates that you can enter one 
of three possible values for an option: 
low, medium, or high.)

_ Connects terms that are read as a single term 
by the system, such as 
set_annotated_delay

Control-c Indicates a keyboard combination, such as 
holding down the Control key and pressing c.

\ Indicates a continuation of a command line.

/ Indicates levels of directory structure.

Edit > Copy Indicates a path to a menu command, such as 
opening the Edit menu and choosing Copy.
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Customer Support

Customer support is available through SolvNet online customer 
support and through contacting the Synopsys Technical Support 
Center.

Accessing SolvNet

SolvNet includes an electronic knowledge base of technical articles 
and answers to frequently asked questions about Synopsys tools. 
SolvNet also gives you access to a wide range of Synopsys online 
services including software downloads, documentation on the Web, 
and “Enter a Call to the Support Center.”

To access SolvNet,

1. Go to the SolvNet Web page at http://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not 
have a Synopsys user name and password, follow the 
instructions to register with SolvNet.)

If you need help using SolvNet, click SolvNet Help in the Support 
Resources section.
xxii
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Contacting the Synopsys Technical Support Center

If you have problems, questions, or suggestions, you can contact the 
Synopsys Technical Support Center in the following ways:

• Open a call to your local support center from the Web by going to 
http://solvnet.synopsys.com (Synopsys user name and 
password required), then clicking “Enter a Call to the Support 
Center.”

• Send an e-mail message to support_center@synopsys.com.

• Telephone your local support center.

- Call (800) 245-8005 from within the continental United States.

- Call (650) 584-4200 from Canada.

- Find other local support center telephone numbers at 
http://www.synopsys.com/support/support_ctr.
xxiii
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Preparing for Installation 1

This chapter provides information about steps to complete before 
you install Synopsys tools. 

The chapter contains the following sections:

• Checking Your Hardware and Software Configuration

• Acquiring a License

• Finding Your Site Identification Number

• Creating the Synopsys Root Directory

• Defining the SYNOPSYS Environment Variable
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Checking Your Hardware and Software Configuration

You must check your hardware and software configuration (including 
patch requirements) before you attempt to load any Synopsys tools.

Supported Platforms and Operating Systems

Table 1-1 lists the supported platforms, operating systems, and 
corresponding Synopsys platform keywords for the T-2002.12, 
T-2002.09, 2002.05, and 2002.03 releases. Many platforms require 
operating system (OS) patches, including year 2002 patches. For 
detailed information, see the Qualified Runtime System 
Configuration page on the Synopsys Web site. Go to

http://www.synopsys.com/products/sw_platform.html

and click Qualified Runtime System Configuration.

This Web page provides information about supported hardware, 
operating systems, and required OS patches. If the required patch 
described in the Qualified Runtime System Configuration is not 
available from the platform vendor, install the most recent patch 
instead. 
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HP-UX Requirements

The HP-UX operating system has the following requirements:

• Local (non-NFS) file systems must be configured for long file 
names.

See the /etc/convertfs man page for details.

• The chown privilege must be switched off.

To switch off chown, enter 

% setprivgrp -n chown

See the setprivgrp man page for details. 

Table 1-1 Supported Platforms, Operating Systems, and Keywords 

Platform Operating system Synopsys platform keywords Windows 
environment

HP HP-UX 11.0, 11.11 (11i) hp32 (32-bit mode)
hp64 (64-bit mode)

CDE
CDE

Sun Solaris 7, 8 sparcOS5 (32-bit mode)
sparc64 (64-bit mode)

CDE

IBM AIX 4.3.3 rs60001

1. Synopsys rs6000-based products are no longer available on CD. They will be available for download by 
EST at a later date. For availability, check with your Synopsys sales representative.

CDE

Intel IA-32 Red Hat Linux 6.2, 7.2 2  

2. Synopsys Linux-based products are compiled under Red Hat Linux 7.2. Support for Red Hat Linux 6.2 
is limited. For details, see “Support for MainWin GUI Problems on Red Hat Linux 6.2” on page 1-4. 

linux (32-bit mode) GNOME
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IBM AIX 4.3.3 RS/6000 Platform

Beginning September, 2002, the RS/6000-based tools are no longer  
available on CD. Products that support RS/6000 will be available to 
download through EST at a later date. 

For availability, check with your Synopsys sales representative. 

Support for MainWin GUI Problems on Red Hat Linux 
6.2

 All products are binary compatible with Red Hat Linux 6.2 except the  
MainWin GUI-based products—BCView, MemWrap, PathMill, 
PrimePower, TetraMAX, Library Compiler, and Design Vision—
which have separately available executable files that provide support 
for Red Hat Linux 6.2. (For more information on how to obtain these 
executable files, see SolvNet article 002208, “How to Obtain Red Hat 
Linux 6.2 GUI Binaries for v2002.05-SP1 and v2002.09.”)

If you want to run PathMill, PrimePower, TetraMAX, or Library 
Compiler  without the GUI, these products are binary compatible with 
Red Hat Linux 6.2 in shell mode. The special executable files are not 
necessary.

Red Hat Linux 7.2 Shared Object File Problem

 If you receive an error about libncurses.so.4 (cannot open shared 
object file: no such file or directory) when you run a Synopsys tool on 
a Red Hat 7.2 platform, install the ncurses4 package. This package 
is available on the Red Hat CD, or you can download it from the Red 
Hat FTP server at

ftp://ftp.redhat.com/pub/redhat/linux/7.2/en/os/i386/RedHat/RPMS/
ncurses4-5.0-4.i386.rpm
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64-Bit Mode on HP-UX and Solaris Platforms

The Synopsys tools now support 64-bit operation on HP-UX and 
Solaris platforms. When you run the tools in 64-bit mode, the upper 
limit for virtual address space is extended beyond the 4-gigabyte limit 
imposed by the 32-bit mode, allowing you to process larger designs. 
With both the 32-bit and 64-bit platforms installed, you have the 
flexibility to run either 32-bit or 64-bit applications without running out 
of memory. 

You can install the 64-bit version of the Synopsys tools in the same 
root directory as the 32-bit version or in a separate directory. When 
both 32-bit and 64-bit dc_shell executable files are installed and you 
specify dc_shell, the first executable file in the PATH environment is 
invoked. 

Note:   
If you attempt to use the 64-bit mode on a 32-bit platform, you will 
see an error message.

Multiple-Platform Installation

When you install files on a network that connects different platforms, 
the result is the directory tree shown in Figure 1-1.
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Figure 1-1 Illustration of a Multiple-Platform Installation

Each Synopsys product includes a platform-independent package 
(indicated by the shaded box in Figure 1-1) containing files common 
to all platforms. When you select multiple platforms, the installation 
script installs one platform-independent package and a 
platform-dependent package for each selected platform.

If you have previously installed a product and want to add another 
platform, 

1. Rerun the installation script for the product.

2. In the installation script,

- Answer n to the query about installing the 
platform-independent package.

- Specify the new platform when queried about which platform 
to install.

$SYNOPSYS

admin auxx doc dw interfaces libraries packages platform1 

Platform-independent

platform2
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Products and Platforms

Table 1-2 lists the products and their supported platforms. For the 
latest product-specific platform information, see the release notes for 
your tool. 

Table 1-2 Products and Supported Platforms 

Product Product ID Platform keyword

AMPS amps sparcOS5, hp32 

Arcadia arc sparcOS5, sparc64, hp32,  
hp64, rs6000

CoCentric Fixed-Point Designer fxd sparcOS5, hp32, linux 

CoCentric System Studio css sparcOS5, hp32, linux 
gccsparcOS5 

COSSAP cos sparcOS5, hp32, rs6000

Floorplan Compiler fpc sparcOS5, sparc64, hp32, 
hp64

Formality fm sparcOS5, sparc64, hp32,  
hp64, rs6000, linux 

FPGA Compiler II fc2 sparcOS5, hp32

NanoSim (including ADFMI,
    NanoSim Integration with
    VCS, turboWave, Verilog-A,
    and VTRAN)

ns sparcOS5, sparc64, hp32,  
hp64, rs6000, linux 

PathMill pm sparcOS5, sparc64, hp32,  
hp64, rs6000 

PowerArc pa sparcOS5, hp32 

PowerMill (including ADFMI,
    VTRAN, and turboWave)

pw sparcOS5, sparc64, hp32, 
hp64, rs6000

PrimePower pp/pps sparcOS5, hp32, linux
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Note:   
Products that support the RS/6000 platform will be available by 
EST at a later date. For more information, see 
“IBM AIX 4.3.3 RS/6000 Platform” on page 1-4.

Disk Space Requirements

Table 1-3 lists the amount of disk space required to install the various 
Synopsys tools. Each CD also includes this information in the 
top-level README.product_name file.

PrimeTime pt/pts sparcOS5, sparc64, hp32, 
hp64, linux

RailMill rm sparcOS5, sparc64, hp32,  
hp64, rs6000

Synthesis syn sparcOS5, sparc64, hp32,  
hp64, rs6000, linux 

TetraMAX tx/txs sparcOS5, sparc64, hp32, 
hp64, linux, gccsparcOS5

TimeMill (including ADFMI,
    VTRAN, and turboWave)

tm sparcOS5, sparc64, hp32, 
hp64, rs6000

Table 1-3 Disk Space Requirements 

Synopsys product Required size in MB (approximate)

AMPS 
Platform independent
Per platform

35
110

Table 1-2 Products and Supported Platforms (Continued)

Product Product ID Platform keyword
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Arcadia
Platform independent
Per platform

3
400

CoCentric Fixed-Point Designer
Platform independent
Per platform

1
20

CoCentric System Studio
Platform independent
Per platform

700
600

COSSAP online documentation 85 

COSSAP
Platform independent
Per platform

1 
600

Floorplan Compiler
Platform independent
Per platform

50
400

Formality
Platform independent
Per platform

102
132

FPGA Compiler II
Platform independent
Per platform

150
100

NanoSim 
Platform independent
Per platform

50
350

Online documentation (English) 455 

Online documentation (Japanese) 175-180 

PathMill 
Platform independent
Per platform

11
172

Table 1-3 Disk Space Requirements (Continued)

Synopsys product Required size in MB (approximate)
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PowerArc 
Platform independent
Per platform

50
300 

PowerMill 
Platform independent
Per platform

50
300

PrimePower
Platform independent
Per platform

492
122

PrimeTime 
Platform independent
Per platform

300
350

RailMill
Platform independent
Per platform

3
250

Synthesis tools 
Platform independent
Per platform

290 
760 

TetraMAX (overlay)
Platform independent
Per platform

9
40

TetraMAX (stand-alone)
Platform independent
Per platform

9
112

TimeMill 
Platform independent
Per platform

50
300 

Table 1-3 Disk Space Requirements (Continued)

Synopsys product Required size in MB (approximate)
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Memory Requirements

The UNIX kernel defines hard per-process limits on the maximum 
amount of memory that can be used, and the limit command 
creates soft limits. If ignored, these limits can cause processes (jobs) 
to fail even when sufficient memory is available. For more 
information, see “Memory” on page 22-2.

Table 1-4 lists the general guidelines for the minimum amount of 
physical memory and swap space (virtual memory) required to run 
Synopsys tools.  

Table 1-4 Minimum Memory Requirements 

Tool Physical memory (MB) Swap space (MB)

AMPS 256 
Recommended: 1G

512
Recommended: 2G

Arcadia 256 512

CoCentric Fixed-Point Designer 64 140

CoCentric System Studio 256 512

COSSAP 128 512

Floorplan Compiler 256 512

Formality1 256 512

FPGA Compiler II 64 140

NanoSim 150 256

PathMill 256
Recommended: 1G

512
Recommended: 2G

PowerArc 150 256

PowerMill 150 256
1-11

Checking Your Hardware and Software Configuration



Physical Memory Requirements for Synthesis, 
PrimeTime, and Design Budgeting 

To run the synthesis, PrimeTime, or design budgeting tools 
efficiently, the physical memory must equal 25 to 50 percent of the 
swap space. For example, if you have 128 MB of swap space, you 
need at least 32 MB of physical memory. You might need as much as 
64 MB, however. The more physical memory you have, the more 
quickly your job runs.

Swap Space Requirements for Synthesis Tools 

The amount of swap space required by the synthesis tools depends 
on the size and type of each circuit design.

Use the following formula to help you determine the minimum 
amount of available swap space required for HDL designs: 
16.3 MB + (5.9 x (size of the design in K gates)).

PrimePower 128 256

PrimeTime 150 256

RailMill 256 512

Synthesis tools 128 256 

TetraMAX2 256 512 

TimeMill 150 256

1. For large designs, the expected amount of required memory is approximately 1  million 
bytes per 2,000 gates. 
2. Physical memory and swap space requirements are dependent on design size. The above 
figures assume that design size is less than 1 million (equivalent NAND) gates.

Table 1-4 Minimum Memory Requirements (Continued)

Tool Physical memory (MB) Swap space (MB)
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For example, a 5K-gate design requires 16.3 + (5.9 x 5) = 45.8 MB 
of available swap space.

Accessing Memory Beyond 2 GB With 32-Bit 
Synopsys Tools

In general, UNIX-based systems support a maximum memory of 2 
GB for 32-bit processes. However, the following Synopsys tools can 
extend memory beyond 2 GB:

• Behavioral Compiler

• Design Compiler

• DFT Compiler

• Floorplan Compiler

• Floorplan Manager

• Formality

• HDL Compiler (Presto Verilog)

• NanoSim

• Physical Compiler

• Power Compiler

• PowerArc

• PowerMill

• PrimeTime

• TetraMAX

• TimeMill
1-13
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• VHDL Compiler

Note:   

Available memory is space not used by the OS, the windowing 
system, or other applications.

To access memory beyond 2 GB,

1. Do one of the following, depending on the platform you are using:

- For HP-UX,

Make sure your server has HP-UX 11.0 (or later) loaded.

- For Solaris,

Make sure your server has Solaris 7 (or later) loaded.

2. Make sure your server has at least 4 GB of memory (physical and 
swap space) available.

Note:   

Physical memory equals data size plus stack size, and stack 
size is used before data size. Therefore setting stack size to a 
large value causes problems for designs that need to go over 
2 GB. If you set the stack size too high, you cannot get enough 
memory for your data. To check the settings, use the limit 
command at the system prompt. For more information, see 
“Memory” on page 22-2.

3. Make sure the system you are using does not have restrictions 
that prevent you from using more than 2 GB of memory.

4. Create unlimited data size in the shell that you are using: C, 
Bourne, Korn or Bash. If there are systemwide limits on the data 
size you can create, you can remove them or override them. You 
can do this in one of two ways:
1-14

Chapter 1: Preparing for Installation



- Enter one of the following commands:

For C shell,

% limit datasize 3800000 

For Bourne, Korn, or Bash shell,

# ulimit -S -d 3800000 

- Modify the kernel of your server. This approach allows 
everyone using your server to extend memory beyond 2 GB.

Note:   

On HP-UX systems, you will see a data size of 2 GB. This 
value is accurate. After your process reaches the 2-GB limit, 
the Synopsys product extends the address space.

Acquiring a License

The Synopsys Common Licensing (SCL) system provides a single, 
common licensing base for all Synopsys tools. The SCL software 
and the documentation describing how to install and configure it are 
separate from the tools that use it. 

Before you can use the Synopsys tools, you must do the following:

• If you have not already done so, retrieve your license keys from 
the SmartKeys Web page.

• Install the SCL software. 
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Note:   

Installation of Synopsys tools and SCL is not order dependent. 
You can install SCL before or after you install your Synopsys 
tools. However, you cannot use your Synopsys tools until you 
have installed, configured, and started SCL. 

Obtaining Your License Keys 

To obtain your license key file from SmartKeys,

1. Go to the SmartKeys Web page at 

http://www.synopsys.com/smartkeys

2. On the SmartKeys Web page, click Key Retrieval.

3. In the Key Retrieval box, enter the following information:

- Your site ID. This is the numeric site ID that identifies your 
customer site. If you have synthesis, test, or VHDL simulation 
tools installed, you can obtain the site ID by viewing your 
site_info file: $SYNOPSYS/admin/license/site_info. 

- Your host ID (optional). To obtain a license key file for a single 
host, enter its host ID. To obtain license keys for all hosts at the 
specified site, leave this field blank.

- Your e-mail address. The default is your Synopsys e-mail 
address. This is the address that your key file will be sent to.

4. Click Continue to submit your request.
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Installing Synopsys Common Licensing Software

You need to install, configure, and start a single copy of SCL 
software for all Synopsys tools. If you don’t have the SCL software, 
you can download it by EST or FTP: See  the 
http://www.synopsys.com/keys/#download_SCL Web page.

Alternatively you can order the SCL software CD from the Synopsys 
MediaDocs Shop at http://mediadocs.synopsys.com.

If you already have SCL running, you do not need to reinstall it. 
However, if you are updating your license key file, you need to notify 
the SCL daemons that the license file has changed. See the SCL 
documentation for instructions on this process.

Note:   
Do not install SCL into an existing directory. You must install SCL 
into a stand-alone directory.

For more information about licensing, see the following documents:

• Licensing Quick Start

• Licensing Installation and Administration Guide

Soft copies of the Licensing Quick Start document and the Licensing 
Installation and Administration Guide are available in Portable 
Document Format (PDF) from http://www.synopsys.com/keys/
#Info_SCL.
1-17

Acquiring a License



Finding Your Site Identification Number

Before you install any Synopsys product CD, locate and make a note 
of your Synopsys site identification number. Enter your site ID when 
prompted during the installation process.

Your site ID was shipped in the package with your Synopsys tools, 
or if you download the software, it is in your Synopsys Order 
Notification e-mail. If you have trouble locating it, contact your 
Synopsys sales representative. 

Creating the Synopsys Root Directory

To create a new directory tree for the T-2002.12, T-2002.09, 
2002.05, or 2002.03 Synopsys release, enter

% mkdir -p /usr/synopsys/productversion

To set the permissions on the new directory tree, enter this 
command:

% chmod 755 /usr/synopsys/productversion

Important:   
Install each version of the software in a new directory. Do not 
install different versions of Synopsys software in the same 
directory. 
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Defining the SYNOPSYS Environment Variable

Set the SYNOPSYS environment variable ($SYNOPSYS) in the shell 
that you are using: C, Bourne, Korn, or Bash. In the following 
examples, the root_directory argument is the name of the 
Synopsys root directory.

If you are using C shell, enter the following command to set the 
SYNOPSYS environment variable:

% setenv SYNOPSYS root_directory

If you are using the Bourne, Korn, or Bash shell, enter the following 
command to set the SYNOPSYS environment variable:

# SYNOPSYS=root_directory; export SYNOPSYS
1-19
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2
Downloading and Installing the Software 2

This chapter provides information about downloading and installing 
Synopsys tools.

The chapter contains the following sections:

• Downloading and Installing the Software by EST

• Performing EST Installation

• Installing Product Files From a CD

• Installing Tools in the Right Sequence
2-1



Downloading and Installing the Software by EST

You can download Synopsys software in two ways:

• By FTP

• From the Web

For help with download problems, contact the Synopsys Electronic 
Software Transfer department:

E-mail support: est-adm@synopsys.com 
Telephone support: 650-584-1631

To access the online EST Troubleshooting Guide, go to 
http://www.synopsys.com/cgi-bin/est.cgi.

Caution!   
 Install each version of the software in a new directory. Do not 
install different versions of Synopsys software in the same 
directory. 

Using the Product Files

Depending on file size, product files are packaged by one of three 
processes, tar, tar.Z, or tar.gz. These instructions cover each 
process.

The product files use the following naming convention:

For .tar files

productname_productversion_common.tar
productname_productversion_platform.tar
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For tar.Z files

productname_productversion_common.tar.Z
productname_productversion_platform.tar.Z

For tar.gz files

productname_productversion_common.tar.gz
productname_productversion_platform.tar.gz

For each tool you want to install, substitute the appropriate product 
ID and version for productname_productversion and platform 
keyword for platform. (See “Products and Platforms” on page 1-7.)

Important:   
For each product except SOLD, you must install one common file 
(platform-independent package) and one or more 
platform-specific files. (See Figure 1-1 on page 1-6.) For SOLD, 
install one common file only.

Downloading the Files by FTP

To download the files by FTP,

1. For each tool, you must create a separate empty directory to 
download your product files into. For example,

% mkdir /tmp/product
% cd /tmp/product

2. Start an FTP session to ftp.synopsys.com:

% ftp ftp.synopsys.com

3. Enter your SolvNet user name and password.
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4. At the ftp prompt, enter the following commands:

ftp> binary
ftp> cd rev
ftp> cd productname_productversion
ftp> get productname_productversion_common.tar
ftp> get productname_productversion_platform.tar

For a list of supported platforms and products for the T-2002.09, 
2002.05, and 2002.03 releases, see Table 1-2 on page 1-7.

5. Download the files into the directory you just created.

6. For installation instructions, see “Performing EST Installation” on 
page 2-5. 

Downloading the Files From the Web

To download files from the Web,

1. For each tool, you must create a separate temporary directory to 
download your product files into. For example,

% mkdir /tmp/product
% cd /tmp/product

2. Go to the Electronic Software Transfer (EST) Web page at

http://www.synopsys.com/cgi-bin/est.cgi

3. Click the Authenticated Access button.

4. Enter your SolvNet user name and password.

5. Read the legal page and, if you agree, click “Yes, I agree to the 
above terms.”

6. Click the rev folder.
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7. Click the file folder for the product and version you want to install.

8. Download the files into the temporary directory.

Note:   

For each product, you must download one common file 
(platform-independent package) and one or more 
platform-specific files. 

9. For installation instructions, see “Performing EST Installation,” 
next.

Performing EST Installation

To install the software,

1. Untar the .tar files, or untar and uncompress the tar.Z or tar.gz 
files. For example, 

For tar files

% tar xvf productname_productversion_common.tar
% tar xvf productname_productversion_platform.tar

For tar.Z files

% cat productname_productversion_common.tar.Z | uncompress | tar xvf - 
% cat productname_productversion_platform.tar.Z | uncompress | tar xvf - 

or

% zcat productname_productversion_common.tar.Z | tar xvf - 
% zcat productname__productversion_platform.tar.Z | tar xvf - 

For tar.gz files

% gzip -dc productname_productversion_common.tar.gz | tar xvf - 
% gzip -dc productname_productversion_platform.tar.gz | tar xvf - 
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Substitute the appropriate product ID and version for 
productname_productversion and platform keyword for platform. 
(See “Products and Platforms” on page 1-7.)

2. Execute the following command to install the software:

% ./install.now 

To install Synopsys tools, it is recommended that you log on as 
root or have system administrator privileges. You need write 
permission for the installation directory.

3. Answer the installation program prompts.

Important:   

When you are prompted to choose a location for installing the 
software, do not select the temporary files directory. You must 
specify a new directory. Do not install different versions of 
Synopsys software in the same directory. 

Repeat steps 1 through 3 for each tool you want to install. 

Installing Product Files From a CD

Use the same installation procedure to transfer the files from each 
CD (or CD set) to your system.

To install a CD,

1. Mount the CD.

2. Run the installation script.

3. Unmount the CD.
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Complete information about these steps is given in the following 
sections.

Mounting the CD

Mounting the CD might require root access privileges. If you do not 
have root access privileges, see your system administrator for 
instructions on mounting the CD. If you have the proper privileges, 
complete the following steps.

To mount the CD,

1. Place the CD in the CD drive.

2. Create a CD directory. For example, enter

% mkdir /cdrom

3. Mount the CD by using the appropriate command for your 
operating system. For example, enter

% mount -o ro /dev/dsk/c2t1d4s0 /cdrom

Note:   
Mounting instructions are different for each platform. See your 
system documentation for the correct CD mounting commands.

Also, for sparcOS5 with vold (the volume management daemon 
for managing CD and floppy devices), the /cdrom directory 
already exists and the CD is automatically mounted. Therefore, 
use cd  /cdrom/cdrom0 instead of cd /cdrom (and use eject to 
unmount the CD). 
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Installing the Software From the CD 

The following steps apply only to tools that use the standard 
installation. For CD installation of FPGA Compiler II, see “Installing 
the Software” on page 11-3. 

To install the software,

1. Move to the CD-ROM directory. For example, enter

% cd /cdrom

2. View the README.1ST file on the CD for more information. View 
the README.productname file for the most up-to-date disk 
space requirements.

3. Enter the installation command.

% ./install.now

4. Answer the installation program prompts.

If you receive an UNCOMPRESS/TAR ERROR during the 
installation script, rerun the installation command, using the 
-i option to correct the problem. For example, enter

% ./install.now -i

Example 2-1 shows a sample Synopsys media installation script for 
v2002.05 of the synthesis tools; it applies to installation by EST and 
from the CD. Other v2002.05 tools are installed in a similar manner. 
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Note:   
To perform an overlay installation for PrimePower or TetraMAX, 
when you are prompted to select the product you want to install, 
enter pp (for PrimePower) or tx (for TetraMAX). To perform a 
stand-alone installation, enter pps (for PrimePower stand-alone) 
or txs (for TetraMAX stand-alone). 

Example 2-1 Synopsys Media Installation Script for the Synthesis Tools

                   Synopsys Media Installation

Instructions:  The list within {} shows the choices for a given option.
               The entry within [] shows the default selection when you
               hit the Return key.  You can cancel the installation by
               by entering quit when prompted for input.

___________________________________________________________________________

The current mounted Synopsys CD file system is 2002.05.

        VERSION:      2002.05
        PRODUCTS:     syn sf3 sf4 pc
        PLATFORMS:    sparcOS5 
        PART NUMBER:  XXXXXX

___________________________________________________________________________

Install 2002.05 release? {y,n} [y] y

Enter the full path to the directory where you want to install
Synopsys 2002.05 products.  If the directory does not exist,
it will be created.  [/usr/synopsys]: /usr/synopsys/2002.05

Creating Synopsys root directory /usr/synopsys/2002.05 ...

Select Synopsys product(s) to install:
        {
        syn - Core Synthesis Tools
        sf3 - Synopsys Integrator for Falcon Framework MentorC
        sf4 - Synopsys Integrator for Falcon Framework MentorD
        pc  - DALI (Protocol Compiler)
        }
Enter the list of product(s) to install [syn]: syn sf3 pc
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Product(s) selected: syn sf3 pc

Platform Independent Package for a particular product contains 
support files that are common to all the platforms. 
You must install this package for each product if you 
are installing it to the /usr/synopsys/2002.05 
directory for the first time. 

Install Platform Independent Package for syn? {y,n} [y]: y

Install Platform Independent Package for sf3? {y,n} [y]: y

Install Platform Independent Package for pc? {y,n} [y]: y

Platform(s) selected: sparcos5
___________________________________________________________________________

Here is your final selection for installing Synopsys Tools:

    VERSION:   2002.05
    PRODUCTS:  syn sf3 pc
    PLATFORMS: sparcos5

    Synopsys Media Directory (from) : /cdrom
    Synopsys Install Directory (to) : /usr/synopsys/2002.05

    Platform Independent Package(s) for : syn sf3 pc

    Disk space required             : 1138 MB
    Disk space available            : 12918 MB

If all the information is correct, continue with the installation.

___________________________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

INSTALLING syn product, platform_independent package, 2002.05 version.
  uncompress < ./syn.taz | ( cd /usr/synopsys/2002.05; tar xvfp - )
sparcos5
INSTALLING syn product, sparcos5 package, 2002.05 version.
  uncompress < ./sparcos5/syn.taz | (cd /usr/synopsys/2002.05; tar xvfp - )

INSTALLING sf3 product, platform_independent package, 2002.05 version.
  uncompress < ./sf3.taz | ( cd /usr/synopsys/2002.05; tar xvfp - )
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sparcos5
INSTALLING sf3 product, sparcos5 package, 2002.05 version.
  uncompress < ./sparcos5/sf3.taz | (cd /usr/synopsys/2002.05; tar xvfp - )
INSTALLING pc product, platform_independent package, 2002.05 version.
  uncompress < ./sf3.taz | ( cd /usr/synopsys/2002.05; tar xvfp - )
sparcos5
INSTALLING pc product, sparcos5 package, 2002.05 version.

Installing Design Compiler ...

Installing Module Compiler ...

Installing power_estimate ...

Installing Library Compiler ...

Installing BC View ...

Installing MemWrap ...

Installing Design Vision ...

Installing Physical Compiler ...

Synopsys Integrator for Falcon Framework Installation Script
 
Platform [ sparcOS5 ]:  sparcOS5

Falcon Framework Version [ C ]:  C

Synopsys root directory [ /usr/synopsys/2002.05 ]:  /usr/synopsys/2002.05
Synopsys integrator directory [ 
/usr/synopsys/2002.05/sparcOS5/syn/interfaces/mentorC ]:  

Synopsys Site Identification Number appears on the upper right corner
of your Synopsys License Key Certificate.

-n Synopsys Site Identification Number [Hit return for 000]: 000 
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Synopsys License Administrator is a person who must be contacted
for Synopsys product related administrative tasks at your site.

-n Local Synopsys License Administrator [Hit return for customer]: 

License Administrator Contact is the current phone number and/or
Email address of customer.

-n License Administrator Contact [Hit return for ###-#### and/or user@email]: 

Created site file /usr/synopsys/2002.05/admin/license/site_info.

Done.

You must now continue with the product-specific installation procedures,
install the Synopsys keys, and start the license servers.

For more information, refer to ./README.{syn sf3 pc} file(s) and 
the Installation Guide version 2002.05.

Thank you ...

Example 2-2 shows a sample Synopsys media installation script for 
version T-2002.09 of the PrimeTime tools; it applies to installation by 
EST and from the CD. Other version T-2002.09 tools are installed in 
a similar manner. 

Example 2-2 Synopsys Media Installation Script for PrimeTime
Synopsys Media Installation

Instructions:  The list within {} shows the choices for a given option. The entry 
within [] shows the default selection when you hit the Return key.  You can 
cancel the installation by entering quit when prompted for input.
_________________________________________________________

The current mounted Synopsys CD file system is T-2002.09.

        VERSION:     T-2002.09
        PRODUCTS:    pts
        PLATFORMS:   sparcOS5 sparc64 
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        PART NUMBER: XXXXXX

_________________________________________________________
Install T-2002.09 release? {y,n} [y] y

NOTE:  The product(s) pts on this CD-ROM must be installed in a
       standalone directory.

Enter the full path to the directory where you want to install
Synopsys T-2002.09 products.  If the directory does not exist,
it will be created.  [/usr/synopsys]: /usr/synopsys/T-2002.09

Select Synopsys product(s) to install:
        {
        pts - PrimeTime_StandAlone
        }
Enter the list of product(s) to install [pts]: pts

Product(s) selected: pts

The Platform Independent Package for a particular product contains support files 
that are common to all the platforms. 
You must install this package for each product if you are installing it to the 
/usr/synopsys/T-2002.09 directory for the first time. 

Install Platform Independent Package for pts? {y,n} [y]: y

Select platform(s) to install:
        {
        sparcOS5 (for Solaris 7, 8)
        sparc64  (for Solaris 7, 8; 64bit Kernel) 
        }
Enter the list of platform(s) to install [sparcOS5]: sparcOS5
sparcos5

Platform(s) selected: sparcos5
__________________________________________________________

Here is your final selection for installing Synopsys Tools:

    VERSION:   T-2002.09
    PRODUCTS:  pts
    PLATFORMS: sparcos5
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    Synopsys Media Directory (from) : /cdrom
       Synopsys Install Directory (to) : /usr/synopsys/T-2002.09

    Platform Independent Package(s) for : pts

    Disk space required             : 290 MB
    Disk space available            : 10063 MB

If all the information is correct, continue with the installation.

_________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

INSTALLING pts product, platform_independent package, T-2002.09 version. 
uncompress < ./pts.taz | ( cd /usr/synopsys/T-2002.09; tar xvfp - ) sparcos5
INSTALLING pts product, sparcos5 package, T-2002.09 version.
  uncompress < ./sparcos5/pts.taz | (cd /usr/synopsys/T-2002.09; tar xvfp - )

Installing PrimeTime ...

Synopsys Site Identification Number appears on the upper right corner of your 
Synopsys License Key Certificate.

-n Synopsys Site Identification Number [Hit return for 000]: 
000

Synopsys License Administrator is a person who must be contacted for Synopsys 
product related administrative tasks at your site.

-n Local Synopsys License Administrator [Hit return for ryang]: 

License Administrator Contact is the current phone number and/or Email address 
of ryang.

-n License Administrator Contact [Hit return for ###-#### and/or user@email]: 

Created site file /usr/synopsys/T-2002.09/admin/license/site_info.

Done.

You must now continue with the product-specific installation procedures, install 
the Synopsys keys, and start the license servers.
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For more information, refer to ./README.{pts} file(s) and 
the Installation Guide.

Thank you ...

Unmounting the CD

To unmount the CD,

1. Move to another directory. For example, enter

% cd /tmp

2. Unmount the CD by using the appropriate command for your 
operating system. For example, enter

% umount /cdrom

Note:   

If you are running the volume management daemon, use the 
eject command to unmount the CD.

3. Remove the CD from the drive.

Installing Tools in the Right Sequence

The order in which you install the Synopsys tools is important. For 
example, install these tools in the following sequence:

1. Synthesis tools

2. TetraMAX

3. Synopsys Online Documentation (SOLD)
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Note:   
To run the Synopsys tools, you must have installed Synopsys 
Common Licensing (SCL) software. For details about Synopsys 
licensing software, see the Licensing Quick Start document and 
the Licensing Installation and Administration Guide.

The following chapters discuss the installation of these tools.
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3
Installing the Synopsys Synthesis Tools 
(version 2002.05) 3

This chapter contains the following sections:

• Synthesis Tools

• Installing the Software

• Configuring the Synthesis Tools

• Installing Optional Tools

• Verifying the Synthesis Tools Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).
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• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Beginning with the 2002.05 release, PrimeTime no longer overlays 
the synthesis tools. 

Synthesis Tools

The Synopsys synthesis tools include the following:

• Core synthesis tools

- Automated Chip Synthesis

- BCView

- Behavioral Compiler

- CoCentric SystemC Compiler

- Design Analyzer

- Design Compiler

- Design Vision

- DesignWare 

- DFT Compiler

- EDIF 2 0 0 Interface

- Floorplan Manager

- HDL Compiler (Presto Verilog)
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- Library Compiler

- Module Compiler

- Physical Compiler

- Power Compiler

- Protocol Compiler

- VHDL Compiler

• Synopsys Integrator for Falcon Framework

- Mentor C version

- Mentor D version

If you have purchased any of these tools, you must install the 
Synthesis tools suite. 

Even though the synthesis tools install as a suite, individual products 
within the suite might not be available on all platforms. Table 3-1 
shows the supported platform for each synthesis tool. (For the most 
recent information about supported platforms for a specific tool, see 
the product-specific release note.)

Table 3-1 Synthesis Tools and Supported Platforms 

Synthesis tools sparcOS5 sparc64 hp32 hp64 linux rs6000

Automated Chip Synthesis x x x x x x

BCView x x x x

Behavioral Compiler x x x x x x

CoCentric SystemC Compiler x x

Design Analyzer x x x x
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Installing the Software 

To download and install the synthesis tools from the Web or by FTP, 
follow the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To transfer the files from the Synthesis CD to your system, follow the 
installation procedure described in “Installing Product Files From a 
CD” on page 2-6.

Design Compiler x x x x x x

Design Vision x x x x

DesignWare x x x x x x

DFT Compiler x x x x x x

EDIF 2 0 0 Interface x x x x x x

Floorplan Manager x x x x x x

HDL Compiler (Presto Verilog) x x x x x x

Library Compiler1 x x x x x x

Module Compiler x x x x x x

Physical Compiler x x x x x x

Power Compiler x x x x x x

Protocol Compiler x x x

VHDL Compiler x x x x x x

1. The Library Compiler GUI is not supported on sparc64 or hp64 platforms.

Table 3-1 Synthesis Tools and Supported Platforms (Continued)

Synthesis tools sparcOS5 sparc64 hp32 hp64 linux rs6000
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On the sparcOS5 platform, you can choose to install either version 
C (sf3) or D (sf4) of the Synopsys Integrator for Falcon Framework 
product, but not both. On the hp32 platform, you can install only 
version D (sf4).

Example 2-1 on page 2-9 shows a sample Synopsys media 
installation script for the synthesis tools.

Configuring the Synthesis Tools

This section describes how to

• Set up the systemwide defaults for the synthesis tools

• Set up the synthesis tools for each user

Setting Up the Systemwide Defaults

If you are using the Design Analyzer product, you can customize the 
display for all users at a site by modifying the Design Analyzer 
application defaults (app-defaults) file. This file is placed in the 
following location during installation:

$SYNOPSYS/admin/setup/Design_analyzer

To see a list of available colors for the Solaris 7 and 8 platforms,  
enter

% more /usr/openwin/lib/X11/rgb.txt

For all other platforms, enter

% more /usr/lib/X11/rgb.txt
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To see a list of available fonts, enter

% xlsfonts | more

To install the changes, copy the modified app-defaults file into the 
systemwide app-defaults location, which varies from site to site. To 
find the systemwide location at your site, contact your system 
administrator.

Note:   
You must have root access privileges to install this systemwide 
defaults file.

If your app-defaults location is in X11 (a common location), install the 
Design_analyzer file by entering a command similar to the one in the 
following example:

% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/openwin/lib/X11/app-defaults

% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/lib/X11/app-defaults

Setting Up the Synthesis Tools for Each User

To set up a new synthesis tools user,

1. Add the synthesis executable directory to the PATH environment 
variable.

If you are using the C shell, add the following line to the .cshrc 
file:

set path=($SYNOPSYS/platform/syn/bin $path)
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If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

When you install the synthesis files, a copy of the synthesis setup 
file is placed in $SYNOPSYS/admin/setup/.synopsys_dc.setup.  
The .synopsys_dc.setup file contains the system defaults for the 
synthesis tools. You can modify this file to customize the settings 
for your environment.

2. Place a .synopsys_dc.setup file in the user’s home directory.

If you are using the C shell, enter

        % cp $SYNOPSYS/admin/setup/.synopsys_dc.setup ~/.synopsys_dc.setup

If you are using the Bourne, Korn, or Bash shell, enter

       # cp $SYNOPSYS/admin/setup/.synopsys_dc.setup $HOME/.synopsys_dc.setup

You can modify this file to customize the settings for each user.

3. To use a graphical user interface (GUI), such as Design Analyzer, 
you must also add the X Window System executable files to the 
PATH environment variable.

If you are using the C shell, add the following line to the .cshrc 
file:

set path=(/usr/dt/bin /usr/bin/X11 $path)

For Solaris 7 or 8, add
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set path=(/usr/dt/bin /usr/openwin/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=/usr/dt/bin:/usr/bin/X11:$PATH
export PATH

For Solaris 7 or 8, add

PATH=/usr/dt/bin:/usr/openwin/bin/X11:$PATH
export PATH

You can customize the GUI display for an individual user by adding 
color and font definitions to the .Xdefaults file in each user’s login 
directory. Values defined in the .Xdefaults file override the values in 
the systemwide app-defaults file.

Additional SystemC Compiler SetUp for Each User

To set up a CoCentric SystemC Compiler user, in addition to the 
other synthesis settings, you must define the absolute path to a C++ 
compiler and the compiler options.

If you are using the C shell, add the following lines to the .cshrc file:

setenv SYSTEMC_CPP "compiler_home options"

If you are using the Bourne, Korn, or Bash shell, add the following 
lines to the .profile, .kshrc, or .bashrc file:

SYSTEMC_CPP=compiler_home options
export SYSTEMC_CPP
3-8

Chapter 3: Installing the Synopsys Synthesis Tools (version 2002.05)



For the GNU C++ Compiler (version 2.95.2 or later), replace 
compiler_home with the absolute path to the GNU C++ Compiler, 
and replace options with the typical compiler options you use. For 
example,

setenv SYSTEMC_CPP "/usr/local/bin/gcc -E -C"

For the Sun SparcWorks C++ Compiler (version 5.0 or later), replace 
compiler_home with the absolute path to Sun SparcWorks C++ 
Compiler, and replace options with the typical compiler options you 
use. For example,

setenv SYSTEMC_CPP "/usr/local/bin/cc -E -xCC -Xc"

The SystemC Compiler default path to the SystemC library include 
files is $SYNOPSYS/auxx/systemc/include. To define a different 
path to the SystemC library include files, specify the -I option for 
SYSTEMC_CPP. For example,

setenv SYSTEMC_CPP "/usr/local/bin/gcc -E -C
       -I/my_systemc/include"

Configuring the Browser for Physical Compiler and 
Design Vision Online Help

The Physical Compiler and Design Vision online Help systems are 
browser-based HTML Help systems. For optimal viewing,  use 
Netscape Navigator version 4.78 for UNIX. These Help systems are 
not supported in Netscape Navigator version 6 or later.
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Both Help systems make extensive use of Java, JavaScript, and 
style sheets. In your browser preferences, select the Advanced 
category and make sure that 

• The Enable Java, Enable JavaScript, and Enable Style Sheets 
options are all selected

• The Enable Java Plugin option is deselected

You can open either Help system from within its respective GUI tool 
or open it stand-alone in Netscape Navigator. 

Installing Optional Tools

The synthesis media installation script automatically installs most of 
the synthesis tools. However, the following tools require manual 
setup or installations:

• Synopsys Integrator for Falcon Framework

• Power Compiler VPOWER

Installing Synopsys Integrator for Falcon Framework

To complete the setup for the Synopsys Integrator for Falcon 
Framework product, set the SYNOPSYS_IFF_ROOT environment 
variable to point to the Synopsys integrator directory.

When asked for the Falcon Framework version, enter

• C if you selected the sf3 product from the installation script

• D if you selected the sf4 product from the installation script
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Note:   

You can install Falcon Framework version C or D, but not both. 
Version C is supported only on the Solaris 7, 8 (sparcOS5) 
operating system; version D is supported on both HP-UX 11.0, 
11.1i (hp32) and Solaris 7, 8 (sparcOS5) operating systems.

If you are using the C shell, add the following line to the .cshrc file:

setenv SYNOPSYS_IFF_ROOT $SYNOPSYS/platform/syn/interfaces/mentorC

If you are using the Bourne, Korn, or Bash shell, add the following 
lines to the .profile file:

SYNOPSYS_IFF_ROOT=$SYNOPSYS/platform/syn/interfaces/mentorC 
export SYNOPSYS_IFF_ROOT

Replace platform with one of the following: hp32 or sparcOS5.

Installing Power Compiler VPOWER

VPOWER is the Power Compiler interface to VCS, the Cadence 
Verilog-XL and NC-Verilog simulators, and the MTI Verilog simulator. 
VPOWER contains user tasks that allow you to monitor toggle 
activity during simulation and to output the information in a form 
readable by Power Compiler. To use VPOWER, link the user tasks 
to the executable file of your simulator. 

The following sections describe the steps for linking VPOWER with 
Verilog-XL and VCS simulators only. For information about linking 
VPOWER with other simulators, see the Power Compiler User 
Guide. 
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Verilog-XL Simulator

The following procedure describes how to link VPOWER to a version 
of the Verilog-XL simulator that contains the standard features you 
normally use at your site and includes the toggle count utilities 
needed for Power Compiler.

Note:   
You must perform this installation on a machine that has access 
to your Verilog-XL simulator vendor distribution.

Consult your Verilog system administrator to obtain the following 
information before beginning the VPOWER installation:

• The directory path to your Verilog .o, .a, and .h files

• The directory location of your central Verilog distribution, for 
obtaining a current site copy of the veriuser.c file

This installation requires modification of your veriuser.c file. By 
obtaining a current site copy of the veriuser.c file, you can be sure to 
include any current site modifications when you modify this file.

To install VPOWER,

1. Change to the Synopsys vpower directory.

2. Modify a copy of your site veriuser.c file.

3. Link the VPOWER user tasks to the simulation executable file.

4. Copy the linked executable file.

The following sections describe these steps.
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Changing to the Synopsys power Directory. All directories listed 
are relative to the root of the vpower directory: $SYNOPSYS/auxx/
syn/power/vpower.

To change to the Synopsys vpower directory,

1. Make sure the environment variable $SYNOPSYS is set.

% echo $SYNOPSYS

If it is not set, set it to the correct value.

% setenv $SYNOPSYS root_directory

2. Change to the Synopsys vpower directory.

% cd $SYNOPSYS/auxx/syn/power/vpower

Modifying the veriuser.c File. To modify the veriuser.c file to define 
the new toggle count utilities,

1. Change to the vxl/vxl.sample directory, and review the sample 
veriuser.c file, which shows the edits you will have to make.

% cd vxl/vxl.sample

2. Copy your current site version of veriuser.c into the sample 
directory. To copy veriuser.c, you must know the directory 
location of your central Verilog distribution.

% cp site_location_dir_path/veriuser.c .

By using a current site copy of veriuser.c, you ensure that any 
existing customizations are included in the VPOWER installation.
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3. As shown in the sample veriuser.c file, make the following 
changes in your current site copy of veriuser.c:

- Add the following line:

# include "tc_extern.h"

- Add the following user tasks:

{usertask, 0, 0, 0, tc_set, tc_set_sync, "$toggle_set", 1},
{usertask, 0, 0, 0, tc_start, 0, "$toggle_start", 1},
{usertask, 0, 0, 0, tc_stop, 0, "$toggle_stop", 1},
{usertask, 0, 0, 0, tc_reset, 0, "$toggle_reset", 1},
{usertask, 0, 0, 0, tc_compatibility, 0, "$toggle_count", 1},
{usertask, 0, toggle_report_check, 0, toggle_report, 0, "$toggle_report", 0},
{usertask, 0, 0, 0, read_lib_saif, tc_lib_sync, "$read_lib_saif", 1},
{usertask, 0, 0, 0, read_rtl_saif, tc_set_sync, "$read_rtl_saif", 1},

- Comment out the following line:

char *veriuser_version_str = "";

4. Save your modified veriuser.c file.

5. Exit your text editor and remain in the sample directory to link the 
executable file.

Linking User Tasks to the Simulation Executable File.  
VPOWER provides two ways to link the user tasks to your simulator 
executable file: by using the vconfig utility or by using a UNIX 
makefile. Each method links your simulator to the VPOWER user 
tasks. Choose the method that you find familiar or comfortable.

Using vconfig to Link the Executable File. The vconfig utility 
creates a script called cr_vlog. The cr_vlog script links your 
Verilog-XL simulator’s executable file to the VPOWER user tasks. 
You must define the name of the executable file created by cr_vlog, 
for example, verilog_toggle.
3-14

Chapter 3: Installing the Synopsys Synthesis Tools (version 2002.05)



To use the vconfig method to link your executable file,

1. Use your vconfig utility or an equivalent utility to generate the 
cr_vlog script or an equivalent script.

2. In the script, set an environment variable pointing to the directory 
of the generated library archive. For example (if you are using 
Solaris 7 or later),

setenv PPLILIB "../../lib-sparcOS5/libvpower.a"

3. In cr_vlog, look for the line that includes the math libraries:

-lm \

4. Add a line above this line to include the libvpower.a library. For 
example,

$PPLILIB \
-lm \

5. Run cr_vlog.

% cr_vlog

This script links your executable file to the VPOWER user tasks 
and creates the customized executable file called verilog_toggle. 
For details about linking the programmable language interface 
(PLI) by using the vconfig utility, see the Power Compiler User 
Guide.

Proceed to “Copying the Linked Executable File” on page 3-16.

Using a Makefile to Link the Executable File. Using the UNIX 
make command, you can use a makefile to link your Verilog-XL 
executable file to the VPOWER user tasks. The makefile creates a 
modified executable file called verilog_toggle.
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Two makefiles exist: Makefile.sol and Makefile.hp.

To use the makefile method to link your executable file,

1. Using a text editor such as vi, edit the appropriate makefile to set 
variable values for VERILOG_LIB and VERILOG_INC.

Modify the lines in the makefile to read according to your data. 
For example, enter

VERILOG_LIB = path1
VERILOG_INC = path2

where path1 is the path to your Verilog distribution .o and .a files, 
and path2 is the path to your Verilog distribution .h files.

The VERILOG_LIB variable must point to the directory path of 
the vlog.o and omnitasks.o files. The VERILOG_INC variable 
must point to the directory path of the acc_user.h and veriuser.h 
files.

2. Save the modified makefile and exit your text editor.

3. Use the make utility to link the executable file.

% make -f Makefile.platform

The platform extension is sol or hp.

The make command uses the modified makefile to link your 
executable file, creating a customized executable file called 
verilog_toggle.

Copying the Linked Executable File. After you create your 
customized executable file, change the permissions so that the file 
is not writable, and copy it to a directory suitable for group access.
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Enter the following commands at the UNIX prompt:

% chmod ogu-w verilog_toggle

This removes write access to other, group, and user.

% cp verilog_toggle site_verilog_bin_location

This copies the file to the site_verilog_bin_location directory for 
group access.

VCS Simulator

The following procedure describes how to link VPOWER to a version 
of VCS that contains the standard features you normally use at your 
site and includes the toggle count utilities needed for Power 
Compiler.

Note:   
The PLI library has been tested with VCS version 3.0 and later 
versions. 

To install VPOWER,

1. Change to the Synopsys vpower directory.

2. Modify a copy of the PLI table file.

3. Compile the simulation executable file.

The following sections describe these steps.

Changing to the Synopsys vpower Directory. All directories 
listed are relative to the root of the vpower directory: $SYNOPSYS/
auxx/syn/power/vpower.
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1. Make sure the environment variable $SYNOPSYS is set.

% echo $SYNOPSYS

If it is not set, set it to the correct value.

% setenv $SYNOPSYS synthesis_root_directory

2. Change to the Synopsys vpower directory.

% cd $SYNOPSYS/auxx/syn/power/vpower

Modifying the PLI Table File. To modify the PLI table file 
(vpower.tab) to define the new toggle count utilities,  

1. Change to the vcs/vcs.sample directory, and review the sample 
vpower.tab file, which shows the edits you will have to make.

% cd vcs/vcs.sample

2. Make the necessary changes to the vpower.tab file.

Compiling the Simulation Executable File. VCS is a compiled 
simulator, so you must compile your designs along with VCS libraries 
to make a simulation executable file. To add PLI functionality to the 
simulation executable file, you need to link an extra PLI library when 
you compile your designs.

For Solaris the appropriate PLI library is

../../lib-sparcOS5/libvpower.a

You normally get a VCS simulation executable file by entering the 
following command at the UNIX prompt:

% vcs -Mupdate your_verilog_design_files compiler_options
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 To link with the PLI library, enter 

% vcs -Mupdate \ 
    -P $SYNOPSYS/auxx/syn/power/vpower/vcs/vcs.sample/vpower.tab \   
   your_verilog_design_files compiler_options \
   $SYNOPSYS/auxx/syn/power/vpower/lib-sparcOS5/libvpower.a

This generates an executable file called simv that includes PLI 
functionality.

Note:   
You can copy vpower.tab and libvpower.a into any file locations 
that are convenient for you.

Verifying the Synthesis Tools Installation

Note:   
The Synopsys Common Licensing (SCL) software must be 
installed and SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
must be defined before you can verify the synthesis tools 
installation. For information on installing SCL, see “Acquiring a 
License” on page 1-15.

To verify installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke, for example, Design Compiler, Library Compiler and 
Design Analyzer or Design Vision by entering the following 
commands on a licensed machine: 

% $SYNOPSYS/platform/syn/bin/dc_shell
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% $SYNOPSYS/platform/syn/bin/lc_shell

% $SYNOPSYS/platform/syn/bin/design_analyzer

% $SYNOPSYS/platform/syn/bin/design_vision

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7). Note that not all 
dc_shell-based tools install on all platforms listed under  
“Synthesis.” For information about tool-specific platform support, 
see the documentation for your product.

Note:   
You can also verify other synthesis tools. Use the preceding 
command and replace the executable file name with the name of 
another synthesis tool.

If you get the correct prompt, or if a GUI appears, the installation was 
successful. 
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Installing AMPS (version 2002.03) 4

This chapter contains the following sections:

• Installing the Software

• Setting Up AMPS for Each User

• Verifying the AMPS Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install AMPS from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the AMPS software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. AMPS is installed in a similar 
manner. 

The AMPS tool is on the PathMill CD. AMPS is a stand-alone product 
and cannot be installed over an existing Synopsys product, including 
a prior version of AMPS. You must create a new directory for AMPS.

Setting Up AMPS for Each User

To set up a new AMPS tool user, add the AMPS directory containing 
the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/amps/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/amps/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-7).
4-2

Chapter 4: Installing AMPS (version 2002.03)



Verifying the AMPS Installation

To verify the AMPS installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% $SYNOPSYS/platform/amps/bin/amps

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Run the AMPS GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/amps/bin/amga

4. Exit the GUI by choosing File > Exit in any GUI window.
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Installing Arcadia (version 2002.05) 5

This chapter contains the following sections:

• Installing the Software

• Setting Up Arcadia for Each User

• Verifying the Arcadia Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install Arcadia from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the Arcadia software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-1 on page 2-9 shows a Synopsys media 
installation script for the synthesis tools. Arcadia is installed in a 
similar manner. 

Arcadia is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of Arcadia. You 
must create a new directory for Arcadia.

Note:   
The installation procedure for Arcadia has changed with this 
release. Arcadia now installs by using the install.now script.

Setting Up Arcadia for Each User

To set up a new Arcadia tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install dir
% source CSHRC_platform

The install script for Arcadia creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.
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The CSHRC_platform file contains the line

set path=(/install_directory/platform/arc/bin $path)

where install_directory is the directory in which the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the preceding 
line and set the path from that file.

• If you are using the Bourne or Korn shell, add the following line 
to the .profile file or .kshrc file:

PATH=/install_directory/platform/arc/bin:${PATH}
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

Verifying the Arcadia Installation

To verify the Arcadia installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% DBCONVERT --version

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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3. Run the Arcadia GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/arc/bin/sviewer 

4. Exit the GUI by choosing File > Exit in any GUI window.
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Installing CoCentric Fixed-Point Designer 
(version 2002.05) 6

This chapter contains the following sections:

• Installing the Software

• Installing the SystemC Software

• Setting Up CoCentric Fixed-Point Designer for Each User

• Verifying the CoCentric Fixed-Point Designer Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Note:   
For detailed information on operating systems and acquiring 
patches, see “Supported Platforms and Operating Systems” on 
page 1-2. 

GUI support is available if you are running CoCentric Fixed-Point 
Designer on the Red Hat Linux 7.2 platform. 

Installing the Software

To download and install CoCentric Fixed-Point Designer from the 
Web or by FTP, follow the procedures described in “Downloading 
and Installing the Software by EST” on page 2-2.

To install the CoCentric Fixed-Point Designer software from the CD, 
follow the installation procedure described in “Installing Product Files 
From a CD” on page 2-6. Example 2-1 on page 2-9 shows a 
Synopsys media installation script for the synthesis tools. CoCentric 
Fixed-Point Designer is installed in a similar manner. 
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Installing the SystemC Software

During the CoCentric Fixed-Point Designer installation process, a 
compressed tar file containing the compiled version of SystemC 
2.0.1 was copied to $SYNOPSYS/ccfxd.

To install SystemC, 

1. Copy the $SYNOPSYS/ccfxd/SystemC-2.0.1.bin.tar.Z file to the 
directory in which you want to install SystemC. 

2. Uncompress and untar the file. 

3. Set the SYSTEMC_HOME environment variable to point to the 
SystemC 2.0.1 installation directory.

Setting Up CoCentric Fixed-Point Designer for Each 
User

Set the systemwide defaults for each user according to the user’s 
shell and operating system. Table 6-1 lists the path name and 
description of systemwide defaults for CoCentric Fixed-Point 
Designer. 

Note:   
If you are using CoCentric Fixed-Point Designer with CoCentric 
System Studio, you must set the corresponding System Studio 
environment variables.  
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The CoCentric Fixed-Point Designer installation script creates the 
following files and puts them into the $SYNOPSYS/admin/install 
directory:

• environ.csh (C shell)

• environ.sh (Bourne, Korn, or Bash shell)

You might need to modify these files to customize the settings for 
your environment. 

To add CoCentric Fixed-Point Designer to each user’s environment, 
add the following commands to the end of each user’s startup file.

Table 6-1 CoCentric Fixed-Point Designer Systemwide Defaults   

Path name Description

SYNOPSYS Identifies the installation directory for Synopsys 
tools.

SYNOPSYS_CCFXD Identifies the CoCentric Fixed-Point Designer 
installation directory, for example, 
$SYNOPSYS/sparcOS5/ccfxd.

SYSTEMC_HOME Identifies the SystemC installation directory.

COSSAP_DIR Identifies the COSSAP installation directory, for 
example, $SYNOPSYS/sparcOS5/cossap. (This 
variable is needed if you are running CoCentric 
Fixed-Point Designer with COSSAP.)

CCFXD_KEYS Specifies the complete file name of the license 
file. If CCFXD_KEYS is not set, the tool searches 
for other license keys in the following order:

COSSAP_KEYS
SNPSLMD_LICENSE_FILE
LM_LICENSE_FILE
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• If you are using the C shell, add this command to the end of the 
.cshrc file:

source $SYNOPSYS/admin/install/ccfxd/bin/environ.csh

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

. $SYNOPSYS/admin/install/ccfxd/bin/environ.sh

Verifying the CoCentric Fixed-Point Designer 
Installation

To verify the CoCentric Fixed-Point Designer installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% ccfxd 

If CoCentric Fixed-Point Designer is correctly installed, this 
command invokes the tool, displays the welcome screen, and then 
opens CoCentric Fixed-Point Designer Studio.
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Installing CoCentric System Studio 
(version 2002.05) 7

This chapter contains the following sections:

• Installing the Software

• Setting Up CoCentric System Studio for Each User

• Verifying the CoCentric System Studio Installation

• Troubleshooting Startup Problems

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Note:   
CoCentric System Studio works with certain versions of Solaris 
and HP-UX platforms in combination with a C++ compiler. A new 
platform, Solaris 7 or 8 (32-bit mode) with the GCC compiler, is 
available for the CoCentric System Studio tool. To install this 
version of CoCentric System Studio, use gccsparcOS5 as the 
platform keyword.

For detailed information on operating systems and acquiring 
patches, see “Supported Platforms and Operating Systems” on 
page 1-2.

GUI support is available if you are running CoCentric System 
Studio on the Red Hat Linux 7.2 platform. 
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Installing the Software

To download and install CoCentric System Studio from the Web or 
by FTP, follow the procedures described in “Downloading and 
Installing the Software by EST” on page 2-2.

To install the CoCentric System Studio software from the CD, follow 
the installation procedure described in “Installing Product Files From 
a CD” on page 2-6. Example 2-1 on page 2-9 shows a Synopsys 
media installation script for the synthesis tools. CoCentric System 
Studio is installed in a similar manner. 

Setting Up CoCentric System Studio for Each User

This section describes how to set up CoCentric System Studio for 
each user on Solaris and HP-UX platforms.

Set the systemwide defaults for each user according to the user’s 
shell and operating system. Table 7-1 lists the path name and 
description of systemwide defaults for CoCentric System Studio. 

Table 7-1 CoCentric System Studio Systemwide Defaults   

Path name Description

ccss_home Absolute path to the directory created to contain 
the version of the System Studio software

ccss_sim_dir Path to the directory for code generation and 
simulation results (defaults to $HOME/ccss/sim)

compiler_home Absolute path to the C++ compiler home 
directory (typically /opt/SUNWspro on Solaris 
and /opt/aCC on HP-UX)
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For C-Shell Users 

To use the C shell to set up a new CoCentric System Studio tool user, 

1. Add the CoCentric System Studio executable directory to the 
PATH environment variable.

Add the following line to the .cshrc file:

setenv SYNOPSYS_CCSS ccss_home/platform/ccss
setenv CCSS_SIM_DIR ccss_sim_dir
set path = ($SYNOPSYS_CCSS/bin $path)

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

2. If the System Studio license file will not be installed in the default 
location, add the following line to your ~/.cshrc file:

setenv CCSS_KEYS lic_file

3. If the paths to the C++ compiler, debugger, and make command 
are not already included in your ~/.cshrc file, add the following 
line to your ~/.cshrc file:

set path = (compiler_home/bin make_home/bin $path) 

debugger_home Absolute path to the debugger home directory 
(typically /opt/SUNWspro on Solaris and /opt/
langtools on HP-UX)

make_home Absolute path to the make home directory 
(typically /usr/ccs on both Solaris and HP-UX)

Table 7-1 CoCentric System Studio Systemwide Defaults  (Continued) 

Path name Description
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4. Make these changes effective by logging out and logging in again 
or by entering the following command:

source ~/.cshrc

For Bourne Shell Users 

To use the Bourne, Korn, or Bash shell to set up a new user, 

1. In your $HOME directory, add the following lines to the 
appropriate user setup file (.profile, .kshrc, or .bashrc).

SYNOPSYS_CCSS=ccss_home/platform/ccss 
export SYNOPSYS_CCSS 

CCSS_SIM_DIR=ccss_sim_dir 
export CCSS_SIM_DIR 

PATH=$SYNOPSYS_CCSS/bin:$PATH
export PATH 

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

2. If the System Studio license file will not be installed in the default 
location, add the following lines to your setup file:

CCSS_KEYS=lic_file
export CCSS_KEYS

3. If the paths to the C++ compiler, debugger, and make command 
are not already included in your setup file, add the following lines 
to it:

PATH=compiler_home/bin:make_home/bin:$PATH 
export PATH 

4. Make these changes effective by logging out and logging in 
again, or by entering the command

. $HOME/setup_file
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where setup_file is .profile, .kshrc, or .bashrc.

VHDL Simulation

If you intend to use the external simulation interface for VHDL 
cosimulation under the algorithmic domain of System Studio, you 
must ensure that the VHDL packages are analyzed before you use 
them. Your system administrator should analyze the files when 
System Studio is installed. 

The relevant commands are

% cd ccss_home/platform/ccss/packages/vsscli/src

  vhdlan -nc ccss_vsscli_package.vhdl

% cd ccss_home/platform/ccss/packages/bittrue/ \
   vhdlsynopsys/src

   vhdlan -nc ccss_PACKAGE_SYNOPSYS.vhdl 
\LIB_0_0_1_PACKAGE_SYNOPSYS.vhdl

where ccss_home is the System Studio installation directory.

Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-7).
7-6

Chapter 7: Installing CoCentric System Studio (version 2002.05)



Verifying the CoCentric System Studio Installation

To verify the CoCentric System Studio installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% ccss &

If System Studio is correctly installed, this command invokes System 
Studio, displays the System Studio welcome screen, and then opens  
System Studio.

Troubleshooting Startup Problems

This section addresses common startup problems.

Key File Problems

To test the System Studio installation, start the System Studio 
Design Center. If the software does not start, check the contents of 
the key file as follows:

1. If you are using a network license file, check the first line of the 
key file and make sure the host name and the host ID match 
those of the machine on which the license is running.

SERVER hostname hostid 26585
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2. If you are using a network license file, check the second line of 
the key file and make sure the path to snpslmd exists and is 
correct.

VENDOR snpslmd scl_root/platform/bin/snpslmd

In this line, platform is the operating system keyword (see 
Table 1-1 on page 1-3). Make sure there are no blank lines and 
no leading or trailing spaces in the license file.

3. For all types of license files, make sure that all System Studio 
users have read access to the key file.

Set the file permission for the key file with the following 
command:

% chmod 644 ccss_home/ccss/admin/license/CCSS.KEYS 

Or, if you have defined the symbol CCSS_KEYS, use this 
command:

% chmod 644 $CCSS_KEYS

Then use the following command to check that the read access 
is correct:

% ls -l $SYNOPSYS_CCSS/../ccss/admin/license/CCSS.KEYS

You should see a report something like this:

-rw-r--r-- 1 thisuser group 4623 Apr 26 11:09 CCSS.KEYS
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Insufficient Interprocess Communication (IPC) 
Semaphores

When starting CoCentric System Studio or CoCentric DAVIS on 
Solaris 5.x platforms, if you see the following report,

sem_create->semget->IPC_CREATE: No space left on device
GMA failed
FATAL: Exec_ .../sparcOS5/ccss/bin/ccss_exec_ failed:status = 139 

you need to increase the number of system semaphores. Add the 
following command to the /etc/system file (see the man page 
system(4) for details):

set semsys:seminfo_semmnu=0x100

After you change the /etc/system file, restart your system by using 
boot -r.

Caution!   
Changing the /etc/system file incorrectly will prevent the 
system from starting.
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Installing COSSAP (version 2002.05) 8

This chapter contains the following sections:

• Installing the Software

• Running the COSSAP Installation Script

• Setting Up COSSAP for Each User

• Defining the Printers

• Verifying the COSSAP Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Note:   
If you need either the VHDL Code Generator or the HDL 
Simulation Interface, “Installing Optional Tools” on page 3-10.

Installing the Software

To download and install COSSAP from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the COSSAP software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 8-1 shows a sample Synopsys COSSAP media 
installation script. 

Example 8-1 Synopsys COSSAP Media Installation Script
Synopsys Media Installation

Instructions: The list within {} shows the choices for a given option. 
The entry within [] shows the default selection when you
hit the Return key. You can cancel the installation by 
entering quit when prompted for input.

_____________________________________________________________

The current mounted Synopsys CD file system is 2002.05.

    VERSION:     2002.05
    PRODUCTS:    cos
    PLATFORMS:   sparcOS5 hp32 
    PART NUMBER: 00315-000 NA
_____________________________________________________________

Install 2002.05 release? {y,n} [y] y
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Enter the full path to the directory where you want to install
Synopsys 2002.05 products. If the directory does not exist,
it will be created. [/usr/synopsys/2002.05]: /usr/synopsys/2002.05

Creating Synopsys root directory /usr/synopsys/2002.05 ...
 
Product(s) selected: cos
 
Platform Independent Package for a particular product contains 
support files that are common to all the platforms.
You must install this package for each product if you
are installing it to the /usr/synopsys/2002.05 directory for the first time. 

Install Platform Independent Package for cos? {y,n} [y]: y
 
Select platform(s) to install:
   {
   sparcOS5 (for Solaris 7,8)
   hp32
   }
Enter the list of platform(s) to install [sparcOS5]: sparcOS5
sparcos5
 
Platform(s) selected: sparcos5
_____________________________________________________________

Here is your final selection for installing Synopsys Tools:

 VERSION:   2002.05
 PRODUCTS:  cos
 PLATFORMS: sparcos5

 Synopsys Media Directory (from) : /cdrom
 Synopsys Install Directory (to) : /usr/synopsys/2002.05

 Platform Independent Package(s) for : cos

 Disk space required             : 600 MB
 Disk space available            : 2170 MB

If all the information is correct, continue with the installation.
_____________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt. 

INSTALLING cos product, platform_independent package,  2002.05 version.
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  uncompress < ./cos.taz | ( cd /usr/synopsys/2002.05; tar xvfp - )
sparcos5
INSTALLING cos product, sparcos5 package, 2002.05 version.
  uncompress < ./sparcos5/cos.taz | (cd /usr/synopsys/2002.05; tar xvfp - )

Synopsys Site Identification Number appears on the upper right corner
 of your Synopsys License Key Certificate. 

-n Synopsys Site Identification Number [Hit return for 000]: 000

Synopsys License Administrator is a person who must be contacted
for Synopsys product related administrative tasks at your site. 

-n Local Synopsys License Administrator [Hit return for customer]: 
 
 
License Administrator Contact is the current phone number and/or
 Email address of customer. 

-n License Administrator Contact [Hit return for ###-#### and/or user@email]: 

Created site file /usr/synopsys/2002.05/admin/license/ site_info. 

Done. 

You must now continue with the product-specific installation procedures,
install the Synopsys keys, and start the license servers.

For more information, refer to ./README.{cos} file(s) and 
the Installation Guide: UNIX-Based Platforms. 

Thank you ...
_____________________________________________________________
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Running the COSSAP Installation Script

To complete the installation for COSSAP, 

1. Change your current working directory to the Synopsys root 
directory.

% cd $SYNOPSYS

2. Run the COSSAP installation script on each platform on which 
you want to install COSSAP.

% platform/cossap/bin/install_cossap

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

The install_cossap script prompts you to confirm installation 
defaults or change the values. To use the defaults, press Return. 
To change values, enter new parameters.

The install_cossap script defines the COSSAP_DIR environment 
variable as $SYNOPSYS/platform /cossap, where  platform  is 
the platform keyword.

Example 8-2 shows the install_cossap script for the sparcOS5 
platform.

Example 8-2 COSSAP Installation Script for sparcOS5
Enter the SYNOPSYS base install directory [/usr/synopsys/2002.05]: <return>
$SYNOPSYS is /usr/synopsys/2002.05
$COSSAP_DIR is /usr/synopsys/2002.05/sparcOS5/cossap

Do you want to continue with the installation {yes|no} [yes]? <return>

Setting up $COSSAP_DIR/admin/install. Note: A warning about
newsim.sim is usually OK
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For running simulations COSSAP manages a ’netlist number’ in a file
which must be writeable for all COSSAP machines in your network.
Please enter the path name [/usr/synopsys/2002.05/sparcOS5/cossap/admin/install/
newsim.sim] :<return>
Enter the first netlist number { >200 } [201]: <return>
Netlist number set.

Do you want to add OpenWindows to the search path in the user’s
environment {yes|no} [no]: yes
Enter the OpenWindows home directory [/usr/openwin]: <return>
Do you want to add the Compiler directory to the search path in the
user’s environment {yes|no} [no]: yes
Enter the SPARCompiler root directory [/opt/SUNWspro]: <return>

Note: The vhdlan executable could not be found in the Synopsys 
~~~~~ installation in order to analyze the COSSAP VHDL packages.

  If you want to use the VHDL Code Generator (VCG) or the VHDL 
Simulation Interface (VSI) then you can analyze the COSSAP 

  VHDL packages by installing the Synopsys Simulation CD and 
   restarting the install_cossap script on this machine using the 

-p option: 
                install_cossap -p

Installation completed.

Note: It is recommended that you check $COSSAP_DIR/admin/install/cshrc.user 
~~~~~ and $COSSAP_DIR/admin/install/profile.user to verify the correct 
 setting of the environment.
  
   To add COSSAP to the user’s environment, include one of the following 
  code fragments at the end of the user’s .profile or .cshrc file:

.profile:
SYNOPSYS=/usr/synopsys/2002.05; export SYNOPSYS
if [ -f "${SYNOPSYS}/sparcOS5/cossap/admin/install/profile.user" ];then

. "${SYNOPSYS}/sparcOS5/cossap/admin/install/profile.user"
fi

   .cshrc:
 setenv SYNOPSYS /usr/synopsys/2002.05

if ( -f "${SYNOPSYS}/sparcOS5/cossap/admin/install/cshrc.user" ) then
source "${SYNOPSYS}/sparcOS5/cossap/admin/install/cshrc.user"

endif
_____________________________________________________________
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To analyze the COSSAP VHDL packages in an existing COSSAP 
installation,

1. Install the Synopsys Simulation CD.

2. Run the install_cossap script with the -p option. For example,

% $SYNOPSYS/platform/cossap/bin/install_cossap -p

The -p option directs the script to analyze only the VHDL 
packages. The script does not perform the other installation 
steps. 

Setting Up COSSAP for Each User

The COSSAP installation script creates the following files and places 
them in the $COSSAP_DIR/admin/install directory:

• cshrc.user (C shell)

• profile.user (Bourne or Korn shell)

You might need to modify these files to customize the settings for 
your environment.

Add COSSAP to each user’s environment by adding the following 
commands to the end of each user’s startup file:

• If you are using the C shell, add this command to the end of the 
.cshrc file:

source $SYNOPSYS/platform/cossap/admin/install/ \ 
cshrc.user
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• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

. $SYNOPSYS/platform/cossap/admin/install/profile.user

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

Defining the Printers

You can customize the printers used by the Block Diagram Editor or 
the Data Visualization tool. 

Block Diagram Editor

To define the printer used by the Block Diagram Editor tool, modify 
the following file:

$HOME/.synopsys_windows/win.ini

For details about how to modify this file to customize the printer 
choices for the Block Diagram Editor, see the section on customizing 
your printer in the COSSAP Block Diagram Editor User Guide.

Data Visualization Tool

For details about how to modify the printer choices for the Data 
Visualization tool, see the section on printing in the CoCentric DAVIS 
User Guide.
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Verifying the COSSAP Installation

Before you start a COSSAP tool for the first time, you must verify the 
COSSAP environment as an ordinary user. After you log in, make 
sure that you have included the cshrc.user or profile.user file in your 
.cshrc or .profile file, as described in “Setting Up COSSAP for Each 
User” on page 8-7. 

To verify the COSSAP installation and licensing,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Create a default COSSAP project: 

% scp default

This creates a new COSSAP project directory tree in 
$HOME/cossap/default.

3. Install one of the COSSAP Guided Tour examples in your project 
directory:

% cd $COSSAP_DIR/demos/gt_ex01
% ./README
% cdir

4. Run the COSSAP Block Diagram Editor and DAVIS GUIs by 
entering cbde and davis. If you are able to run these tools, the 
installation was successful.

5. To exit these tools, choose File > Exit Application.

For more information about the COSSAP Guided Tour examples, 
see Getting Started With COSSAP.
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Installing Floorplan Compiler 
(version T-2002.12) 9

This chapter contains the following sections:

• Installing the Software

• Setting Up Floorplan Compiler for Each User

• Verifying the Floorplan Compiler Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Installing the Software

To download and install Floorplan Compiler from the Web or by FTP, 
follow the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To install the Floorplan Compiler software from the CD, follow the 
installation procedure described in “Installing Product Files From a 
CD” on page 2-6. Example 2-1 on page 2-9 shows a Synopsys 
media installation script for the synthesis tools. Floorplan Compiler is 
installed in a similar manner. 

Setting Up Floorplan Compiler for Each User

To set up a new Floorplan Compiler tool user, add the Floorplan 
Compiler directory containing the executable file to the PATH 
environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/fpc/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/fpc/bin:$PATH
export PATH
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Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-7).

Configuring the Browser for Floorplan Compiler Online 
Help 

The Floorplan Compiler online Help system is a browser-based 
HTML Help system. For optimal viewing, use Netscape Navigator 
version 4.78 for UNIX. This Help system is not supported in 
Netscape Navigator version 6 or later.

Floorplan Compiler Help makes extensive use of Java, JavaScript, 
and style sheets. In your browser preferences, select the Advanced 
category and make sure that 

• The Enable Java, Enable JavaScript, and Enable Style Sheets 
options are all selected

• The Enable Java Plugin option is deselected

You can open the Help system from within the Floorplan Compiler 
GUI tool or stand-alone in Netscape Navigator. 

Verifying the Floorplan Compiler Installation

To verify the Floorplan Compiler installation, 

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME
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2. Invoke the tool by entering the following command: 

% $SYNOPSYS/platform/fpc/bin/fpc_shell

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Exit fpc_shell by entering exit on the command line.

4. Run the Floorplan Compiler GUI on each installed platform by 
entering the following command:

% $SYNOPSYS/platform/fpc/bin/fpc_gui

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

5. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up Formality for Each User

• Verifying the Formality Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install Formality from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the Formality software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for the PrimeTime tool. Formality is installed in a 
similar manner. 

Formality is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of Formality. You 
must create a new directory for Formality.

Setting Up Formality for Each User

To set up a new Formality tool user, add the Formality directory 
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/fm/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/fm/bin:$PATH
export PATH
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Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-7).

For information about the Synopsys setup file, see the Formality 
User Guide. 

Verifying the Formality Installation

To verify the Formality installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the Formality shell by entering the following command: 

% $SYNOPSYS/platform/fm/bin/fm_shell

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Exit fm_shell by entering exit on the command line.

4. Run the Formality GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/fm/bin/formality

5. Exit the GUI by choosing File > Exit in any GUI window.
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Installing FPGA Compiler II 
(version 2002.05-3.7) 11

This chapter explains how to install FPGA Compiler II on a 
workstation running Solaris or HP-UX. For instructions on how to 
install FPGA Compiler II on a system running a Windows NT 
platform, see Appendix A, “Installing FPGA Compiler II (version 
2002.05-FC3.7) on Windows Platforms.”

This chapter contains the following sections:

• Product Support

• System Requirements

• Installing the Software

• Registering FPGA Compiler II

• Enabling Online Document Readers
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Product Support

The FPGA Solutions Web page is regularly updated. Check it for  
application notes, online Help updates, and other valuable 
information:

http://www.synopsys.com/products/fpga/

For additional installation instructions, go to

http://www.synopsys.com/products/fpga/install_fc2.htm

System Requirements

Table 11-1 shows the minimum system requirements for UNIX 
installations of FPGA Compiler II.      

Table 11-1 UNIX System Requirements

Operating system Memory Disk space for installation

Solaris 7, 8
 (32-bit mode only)

64 MB of RAM

140 MB of swap space1

1. 200 MB of virtual memory (RAM + swap space) is recommended for most designs. Larger 
designs might require more memory. 

100–150 MB

HP-UX 11.0, 11.11 (11i) 
(32-bit mode only)

64 MB of RAM

140 MB of swap space1
100–150 MB
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Installing the Software

Mounting the CD might require root access privileges. If you do not 
have root access privileges, see your system administrator for 
instructions on mounting the CD.

To install FPGA Compiler II,

1. Mount the CD-ROM, following the instructions in “Mounting the 
CD” on page 2-7.

2. Make sure that your licensing software is installed. For 
information on Synopsys Common Licensing (SCL) software, 
see “Acquiring a License” on page 1-15.

3. Change directory to the UNIX directory of the CD-ROM. For 
example, 

% cd /cdrom0/UNIX

4. Run the setup script setup.csh from the UNIX directory of the 
CD-ROM drive and follow the instructions.

5. For a typical shared installation, choose option 1 to install the 
software and set up the license path. 

6. Next, choose option 1 for Solaris, option 2 for HP-UX, or option 3 
for both platforms.

7. Enter the path to the network keys in the format port@hostname 
(for example, 26585@keyserv).
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Registering FPGA Compiler II 

To register your copy of FPGA Compiler II, fill out the registration 
form included with the package software and fax it to the following 
number:

(650) 584-1747

Registering your new system ensures that you receive technical 
support, warranty coverage, special offers and promotions, and early 
notification of future FPGA products and services.

Enabling Online Document Readers

The FPGA Compiler II User Guide is available online in Portable 
Document Format (PDF).

To read this online document, you must have version 4.0 or later of 
Adobe Acrobat Reader with Search plug-in installed on your system. 
To install Acrobat Reader with Search plug-in, download the latest 
version of Acrobat Reader from the Adobe home page, at

http://www.adobe.com

For more information, see “Downloading Acrobat Reader from the 
Web” on page 21-3.
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This chapter contains the following sections:

• Installing the Software 

• Setting Up NanoSim for Each User

• Verifying the NanoSim Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software 

To download and install NanoSim from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the NanoSim software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. NanoSim is installed in a similar 
manner. The NanoSim subtools (ADFMI, NanoSim Integration with 
VCS, turboWave, Verilog-A, and VTRAN) are automatically installed 
with the NanoSim installation. 

NanoSim can be installed as a stand-alone installation or with any of 
the tools (PowerMill, PowerArc, and TimeMill) it comes packaged 
with.

Setting Up NanoSim for Each User

To set up a new NanoSim tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install dir
% source CSHRC_platform

The install script for NanoSim creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.
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The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)

where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=/install_directory/platform/ns/bin:${PATH}
export Path

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7)..

Verifying the NanoSim Installation

To verify the NanoSim installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% nanosim

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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3. Run the NanoSim GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/ns/bin/nanosimgui

4. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PathMill for Each User

• Verifying the PathMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install PathMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the PathMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. PathMill is installed in a similar 
manner. 

PathMill is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of PathMill. You 
must create a new directory for PathMill.

Setting Up PathMill for Each User

To set up a new PathMill tool user, add the PathMill directory 
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/pm/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/pm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and 
Supported Platforms” on page 1-7).
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Verifying the PathMill Installation

To verify the PathMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% $SYNOPSYS/platform/pm/bin/pathmill

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Run the PathMill GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/pm/bin/pathmill -ga

Note:   

The PathMill GUI is available only on 32-bit platforms 
(sparcOS5 or hp32). 

4. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PowerArc for Each User

• Verifying the PowerArc Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install PowerArc from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the PowerArc software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. PowerArc is installed in a similar 
manner. 

PowerArc can be installed as a stand-alone installation or with any of 
the tools (PowerMill, NanoSim, and TimeMill) it comes packaged 
with.

Setting Up PowerArc for Each User

To set up a new PowerArc tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install dir
% source CSHRC_platform

The install script for PowerArc creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)
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where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=/install_directory/platform/ns/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

Verifying the PowerArc Installation

To verify the PowerArc installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% pwarc

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting Up PowerMill for Each User

• Verifying the PowerMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install PowerMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the PowerMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. PowerMill is installed in a similar 
manner. The PowerMill subtools (ADFMI, turboWave, and VTRAN) 
are automatically installed with the PowerMill installation.

PowerMill can be installed as a stand-alone installation or with any of 
the tools (PowerArc, NanoSim, and TimeMill) it comes packaged 
with.

Setting Up PowerMill for Each User

To set up a new PowerMill tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install dir
% source CSHRC_platform

The install script for PowerMill creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.
15-2

Chapter 15: Installing PowerMill (version 2002.03)



The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)

where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=/install_directory/platform/ns/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

Verifying the PowerMill Installation

To verify the PowerMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% powrmill

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting Up PrimePower for Each User

• Verifying the PrimePower Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

PrimePower can be installed as a stand-alone product or as an 
overlay to the 2002.05 version of the synthesis tools. 

• Stand-alone 

Install PrimePower stand-alone in its own directory.

• Overlay 

Install PrimePower overlay in the same directory as the 
Synopsys synthesis tools.

Stand-Alone Installation

PrimePower stand-alone must be installed in its own directory and 
not over an existing synthesis release.

To perform stand-alone installation, 

1. Download and install PrimePower from the Web or by FTP, 
following the instructions described in “Downloading and 
Installing the Software by EST” on page 2-2.

Or

Install the files from the PrimePower CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-6. 
Example 2-1 on page 2-9 shows a Synopsys media installation 
script for the synthesis tools. PrimePower is installed in a similar 
manner. 
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Note:   

When you are prompted to select the product you want to 
install, enter pps to perform a stand-alone installation.

2. Make sure that your licensing software is installed. For 
information on SCL software, see “Acquiring a License” on 
page 1-15.

Overlay Installation

You perform overlay installation in the directory in which you installed 
the Synopsys synthesis tools ($SYNOPSYS). You must log in as the 
same user who installed the Synopsys synthesis tools so that you 
have write permission in the $SYNOPSYS directory.

Note:   
If you have not installed the Synopsys synthesis tools, install 
them before proceeding with overlay installation (see Chapter 3). 
If you do not have the synthesis tools installed, the installation of 
PrimePower overlay will not be allowed.

To perform overlay installation,

1. Download and install PrimePower from the Web or by FTP, 
following the procedures described in “Downloading and 
Installing the Software by EST” on page 2-2.

Or

Install the files from the PrimePower CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-6. 
Example 2-1 on page 2-9 shows a Synopsys media installation 
script for the synthesis tools. PrimePower is installed in a similar 
manner. 
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Note:   

When you are prompted to select the product you want to 
install, enter pp to perform an overlay installation.

2. Make sure your Synopsys license server and license key file are 
set up to work with the synthesis tools. If you encounter 
problems, see the SCL documentation, Licensing Quick Start 
and Licensing Installation and Administration Guide.

Setting Up PrimePower for Each User

To set up a new PrimePower tool user,

1. Add the PrimePower directory containing the executable file to 
the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

Stand-alone

set path=(/install_directory/platform/syn/bin $path)

Overlay

set path=($SYNOPSYS/platform/syn/bin $path)

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

Stand-alone

PATH=/install_directory/platform/syn/bin:$PATH
export PATH
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Overlay

PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

2. Place a .synopsys_pp.setup file in the user’s home directory.

If you are using the C shell, enter

% cp $SYNOPSYS/admin/setup/.synopsys_pp.setup ~/.synopsys_pp.setup

If you are using the Bourne, Korn, or Bash shell, enter

# cp $SYNOPSYS/admin/setup/.synopsys_pp.setup $HOME/.synopsys_pp.setup

You can modify this file to customize the settings for each user.

Verifying the PrimePower Installation

To verify the PrimePower installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% pp_shell

If you see information about the product version, production date, 
and copyright, the installation was successful. 

3. Exit pp_shell by entering exit on the command line.
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4. Run the PrimePower GUI on each installed platform by entering 
the following command:

% primepower &

5. Exit the GUI by choosing File > Exit in any GUI window.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PrimeTime for Each User

• Verifying the PrimeTime, stamp_compiler, and budget_shell 
Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Installing the Software

To download and install PrimeTime from the Web or by FTP, follow 
the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

To install the PrimeTime software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. 

PrimeTime is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of PrimeTime. 
You must create a new directory for PrimeTime.

Note:   
Beginning with the 2002.03 release of PrimeTime, you can no 
longer overlay PrimeTime on the synthesis tools.

Using the PrimeTime Budgeter

After installing PrimeTime, if you want to use the PrimeTime 
budgeter in the Automatic Chip Synthesis flow, add the following line 
to the .synopsys_dc.setup file in the synthesis directory:

set acs_bs_exec full_location_path_PT_executable

By default, Automatic Chip Synthesis uses the Design Compiler 
budgeter. 
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Setting Up PrimeTime for Each User

To set up a new PrimeTime user,

1. Add the PrimeTime directory containing the executable file to the 
PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/syn/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

2. Place a .synopsys_pt.setup file in the user’s home directory.

If you are using the C shell, enter

  % cp $SYNOPSYS/admin/setup/.synopsys_pt.setup ~/.synopsys_pt.setup

If you are using the Bourne, Korn, or Bash shell, enter

  # cp $SYNOPSYS/admin/setup/.synopsys_pt.setup $HOME/.synopsys_pt.setup

You can modify this file to customize the settings for each user.
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Verifying the PrimeTime, stamp_compiler, and 
budget_shell Installation 

Note:   
The Synopsys Common Licensing (SCL) software must be 
installed and SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE 
must be defined before you can verify the PrimeTime tools 
installation. For information on installing SCL, see “Acquiring a 
License” on page 1-15.

To verify installation of the PrimeTime, stamp_compiler, and  
budget_shell tools,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke any of the tools by entering one of the following 
commands on a licensed machine:

% $SYNOPSYS/platform/syn/bin/pt_shell

% $SYNOPSYS/platform/syn/bin/stamp_compiler

% $SYNOPSYS/platform/syn/bin/budget_shell

% $SYNOPSYS/platform/syn/bin/primetime

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

If you get the correct prompt, or if a GUI appears, the installation was 
successful. 
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This chapter contains the following sections:

• Installing the Software

• Setting Up RailMill for Each User

• Verifying the RailMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install RailMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the RailMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-1 on page 2-9 shows a Synopsys media 
installation script for the synthesis tools. RailMill is installed in a 
similar manner. 

RailMill is a stand-alone product and cannot be installed over an 
existing Synopsys product, including a prior version of RailMill. You 
must create a new directory for RailMill.

Note:   
The installation procedure for RailMill has changed. RailMill now 
installs by using the Synopsys ./.install.now script.

Setting Up RailMill for Each User

To set up a new RailMill tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install dir
% source CSHRC_platform

The install script for RailMill creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.
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The CSHRC_platform file contains the line

set path=(/install_directory/platform/rm/bin $path)

where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile or .kshrc file:

PATH=/install_directory/platform/rm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

Verifying the RailMill Installation

To verify the RailMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% railmill

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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3. Run the RailMill GUI on each installed platform by entering the 
following command:

% $SYNOPSYS/platform/rm/bin/chipviewer

4. Exit the GUI by choosing File > Exit, and clicking Yes in the dialog 
box.
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This chapter contains the following sections:

• Installing TetraMAX

• Setting Up the User Environment

• Verifying the TetraMAX Installation

If you are installing TetraMAX stand-alone, to ensure a successful 
installation complete the following procedures before beginning the 
installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).

Installing TetraMAX

This section describes Synopsys license key requirements and the 
two types of installation for TetraMAX ATPG and TetraMAX IddQTest, 
version 2002.05: 

• Stand-alone 

Install TetraMAX stand-alone in its own directory.

• Overlay 

Install TetraMAX overlay in the same directory as the 
2002.05-SP2 synthesis tools. 

License Key Requirements

TetraMAX version T-2002.12 uses the Synopsys Common Licensing 
(SCL) system. For information on installing SCL, see “Acquiring a 
License” on page 1-15.

Note:   
Optional features such as IddQTest, PatternMap, and transition 
delay fault ATPG each require a separate license. For specific 
information on the licenses required for TetraMAX options, install 
the product and see the online Help for the get licenses 
command. 
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64-Bit Mode on HP-UX and Solaris Platforms

In 64-bit mode, TetraMAX supports both the shell and GUI on HP-UX 
and Solaris platforms.

To invoke TetraMAX ATPG in 64-bit mode, use the -64bit switch: 

% tmax -64bit [other options]

An alternative method is to set the TMAX_64BIT environment 
variable to true (or to any string other than null):

% setenv TMAX_64BIT true
% tmax [other options]

Stand-Alone Installation

TetraMAX stand-alone is a complete installation of all TetraMAX 
applications. It must be installed in its own directory and not over an 
existing synthesis release.

To perform stand-alone installation, 

1. Download and install TetraMAX from the Web or by FTP, as the 
described in “Downloading and Installing the Software by EST” 
on page 2-2.

Or

Install the files from the TetraMAX CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-6. 
Example 2-1 on page 2-9 shows a Synopsys media installation 
script for the synthesis tools. TetraMAX is installed in a similar 
manner. 
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Note:   

When you are prompted to select the product you want to 
install, enter txs to perform a stand-alone installation.

2. Make sure that your licensing software is installed. For 
information on SCL software, see “Acquiring a License” on 
page 1-15.

Overlay Installation

Install TetraMAX version version T-2002.12 over version 
2002.05-SP2 of the synthesis tools only. (Do not install it over any 
other versions of the synthesis tools.)

You perform overlay installation in the directory in which you installed 
the Synopsys synthesis tools ($SYNOPSYS). You must log in as the 
same user who installed the Synopsys synthesis tools so that you 
have write permission in the $SYNOPSYS directory.

Note:   
If you have not installed the Synopsys synthesis tools, install 
them before proceeding with overlay installation (see Chapter 3). 
If you do not have the synthesis tools installed, the installation of 
TetraMAX overlay will not be allowed.

To perform overlay installation,

1. To download and install TetraMAX from the Web or by FTP, follow 
the procedures described in “Downloading and Installing the 
Software by EST” on page 2-2.

Or
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Install the files from the TetraMAX CD to your system, as 
explained in “Installing Product Files From a CD” on page 2-6. 
Example 2-1 on page 2-9 shows a Synopsys media installation 
script for the synthesis tools. TetraMAX is installed in a similar 
manner. 

Note:   

When you are prompted to select the product you want to 
install, enter tx to perform an overlay installation.

2. Make sure your Synopsys license server and license key file are 
set up to work with the synthesis tools. If you encounter 
problems, see the SCL documentation, Licensing Quick Start 
and Licensing Installation and Administration Guide.

Optional Installation of IddQTest

The IddQTest option of TetraMAX is installed separately from 
TetraMAX ATPG and requires a special license. 

To install IddQTest,

1. Run the same installation script again, but enter idq at the 
“Product(s) Selected” prompt.

2. For the IddQTest target directory, specify the location where you 
installed the TetraMAX overlay product.

Note:   
The installation script does not allow you to install IddQTest into 
a TetraMAX stand-alone installation.To create a stand-alone 
installation of IddQTest, you must specify a completely separate 
directory. Once you have done this, manually copy IddQTest into 
the same directory as the TetraMAX stand-alone product.
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Setting Up the User Environment

To successfully invoke TetraMAX, you must define a separate 
environment variable, SYNOPSYS_TMAX, and set the path to the 
directory where TetraMAX ATPG is installed.

Perform one of the following procedures for the UNIX version of 
TetraMAX. Note that these examples are for the C shell. Setups in 
other shells will differ.

• To set up the user environment by using an alias, enter

% setenv SYNOPSYS_TMAX $SYNOPSYS
% alias tmax ’$SYNOPSYS_TMAX/bin/tmax \!*’

• To set up the user environment by using a path, enter

% setenv SYNOPSYS_TMAX $SYNOPSYS
% set path=($SYNOPSYS_TMAX/syn/bin $path)

Verifying the TetraMAX Installation

To verify installation of the TetraMAX tools,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the TetraMAX GUI by entering the following command on 
a licensed machine:

% $SYNOPSYS_TMAX/bin/tmax

If the GUI appears, the installation was successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up TimeMill for Each User

• Verifying the TimeMill Installation

To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Have your license server running and have the appropriate 
license keys installed (see “Acquiring a License” on page 1-15).
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Installing the Software

To download and install TimeMill from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2.

To install the TimeMill software from the CD, follow the installation 
procedure described in “Installing Product Files From a CD” on 
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media 
installation script for PrimeTime. TimeMill is installed in a similar 
manner. The TimeMill subtools (ADFMI, turboWave, and VTRAN) 
are automatically installed with the TimeMill installation.

TimeMill can be installed as a stand-alone installation or with any of 
the tools (PowerArc, NanoSim, and TimeMill) it comes packaged 
with.

Setting Up TimeMill for Each User

To set up a new TimeMill tool user,

• If you are using the C shell, source the CSHRC_platform file 
located in the install directory. 

% cd install dir
% source CSHRC_platform

The install script for TimeMill creates a CSHRC_platform file for 
each platform installed. The term platform is replaced with the 
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)
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where install_directory is the directory where the tool has been 
installed.

If you don’t source the CSHRC_platform file, copy the above line 
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following 
line to the .profile, .kshrc, or .bashrc file:

PATH=/install_directory/platform/ns/bin:${PATH}
export PATH

Replace platform with the appropriate platform (see “Products 
and Supported Platforms” on page 1-7).

Verifying the TimeMill Installation

To verify the TimeMill installation,

1. Make sure you are in a directory where you have read/write 
privileges:

% cd $HOME

2. Invoke the tool by entering the following command: 

% timemill

If you see information about the product version, production date, 
and copyright, the installation was successful. 
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(version T-2002.12) 21

This chapter contains the following sections:

• About SOLD

• Acquiring and Installing the Acrobat Software

• Verifying Your Acrobat Software

• Installing SOLD

• Verifying the SOLD Installation

• Configuring SOLD for Each User

• Searching SOLD on Linux
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To ensure a successful installation, complete the following 
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys 
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the 
SYNOPSYS Environment Variable” on page 1-19).

The T-2002.12 version of SOLD contains documentation for the 
T-2002.12, T-2002.09, 2002.05, and 2002.03 releases. You can 
access the documentation by clicking the product name on the 
SOLD front panel.

About SOLD 

This chapter describes how to install and verify Synopsys Online 
Documentation (SOLD). The SOLD CD and the SOLD directory 
contain document files in the cross-platform Adobe Portable 
Document Format (PDF), as well as Portable Document Index files 
(PDX) that enable full-text searching across all SOLD documents.

To read and search these files, you need version 4.0 or later of 
Adobe Acrobat Reader with Search plug-in or Adobe Acrobat. You 
can download Acrobat Reader with Search plug-in free of charge 
from the Adobe Web site. For more information, see “Acquiring and 
Installing the Acrobat Software” on page 21-3.

Note:   
To use the Search plug-in capability for the Linux platform, you 
must have Adobe Acrobat version 5.0. See “Searching SOLD on 
Linux” on page 21-13.
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The online documentation for COSSAP (COSSAP SOLD) is 
distributed to COSSAP customers on a separate CD. The installation 
instructions in this chapter apply to both SOLD and COSSAP SOLD.

Acquiring and Installing the Acrobat Software

You can acquire the Acrobat software in three ways:

• By downloading the freeware Acrobat Reader from the Web

• By installing the freeware Acrobat Reader from a CD

• By purchasing Adobe Acrobat 

The following sections describe these options.

Downloading Acrobat Reader from the Web

To download Acrobat Reader from the Adobe Web site, go to 
http://www.adobe.com/ and perform the following procedure. (The 
details of these instructions might change if Adobe modifies its Web 
site.)

1. Click the Get Acrobat Reader button.

2. On the Welcome page, click Get Acrobat Reader.

3. Follow the instructions under “Download Adobe Acrobat Reader.” 

Note:   

Change the platform value to the appropriate OS platform, and 
select the “Include option for searching PDF files” box.

4. Click DOWNLOAD.
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5. Select the “Save to Disk” option.

6. Uncompress the tar.Z or use the gunzip utility for the tar.gz file. 
For example,

% gzip -d solaris-506.tar.gz

7. Untar the resulting file. For example,

% tar xvf solaris-506.tar

8. Enter ./install to start the installation script. 

For more information, consult the instguid.txt installation guide that 
you get when you download Acrobat Reader. 

Installing Acrobat Reader From a CD

If you do not have access to the World Wide Web, you can get a CD 
containing Acrobat Reader software from your Synopsys sales 
representative. You can also order the CD directly from Adobe for a 
nominal fee.

To install Acrobat Reader from a CD,

1. Mount the Acrobat Reader CD.

2. Change the directory to the mount point of the CD-ROM. For 
example,

% cd /cdrom

3. Change the directory to acroread/unix/Rdr_srch (ACROREAD/
UNIX/RDR_SRCH on the HP platform). For example,

% cd acroread/unix/Rdr_srch
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Be sure to install the software from the Rdr_srch directory. Using 
this directory ensures that the Search capability is enabled.

Note:   

Acrobat doesn’t support the search capability for Linux, so you 
will see a different directory if you are running Linux.

4. Enter ./install (or ./INSTALL for the HP platform) to start the 
installation script.

Using Adobe Acrobat

If you choose to purchase Adobe Acrobat (formerly called Acrobat 
Exchange), install it by following the instructions in the product 
documentation.

Adobe Acrobat allows you to alter PDF files in certain limited ways. 
For example, you can add annotations and hypertext links to PDF 
documents. With Acrobat Reader, you can view but not alter PDF 
files.

Verifying Your Acrobat Software

To view SOLD, you must have Acrobat version 4.x or later.

To search SOLD, you must have the Search plug-in. For information 
about searching SOLD on the Linux platform, see “Searching SOLD 
on Linux” on page 21-13.

The following sections describe how to determine your current 
software configuration.
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Checking the Version Number

If you are using 3.x or an earlier version of Acrobat, you must 
upgrade in order to view SOLD. Follow the instructions in “Acquiring 
and Installing the Acrobat Software” on page 21-3.

To check the version number,

1. Open Acrobat Reader or Adobe Acrobat.

2. Choose Help > About Acrobat Reader (or Help > About Adobe 
Acrobat).

3. In the window that appears, verify that the words “Acrobat 
Reader 4.0” or “Adobe Acrobat 4.0” appear. (Later versions of 
Acrobat are also supported.)

4. Close the About screen by clicking anywhere in the window.

Checking for the Search Plug-In

If you are using Acrobat Reader without the Search plug-in, you must 
upgrade in order to have full-text searching capability in SOLD. The 
Search plug-in cannot be downloaded from the Adobe site as a 
separate file; to upgrade, you must download the entire Acrobat 
Reader with Search plug-in package. Follow the instructions in 
“Acquiring and Installing the Acrobat Software” on page 21-3.

To check for the Search plug-in,

1. Open Acrobat Reader or Adobe Acrobat (if it is not already open).

2. Choose Help > About Plug-Ins to verify that Acrobat Search is on 
the list of installed plug-ins.
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Installing SOLD

You can install SOLD by electronic software transfer (EST) or from 
the SOLD CD. 

Contents of SOLD

The SOLD documentation set contains PDF document files, the 
index (PDX) files that enable full-text searching, and the UNIX 
installation scripts. 

SOLD contains several collections of documents. Each collection 
describes a particular subject area and resides in its own directory. 
Each collection directory contains all the PDF files for the books in 
its subject area, as well as the index files for searching in that 
collection.

The README.1ST file in the SOLD directory and on the SOLD CD 
lists the contents of SOLD.

Installation Options

The SOLD installation procedure copies files from the SOLD 
directory (for EST) or SOLD CD into the appropriate places in the 
Synopsys root directory structure.

SOLD offers the following installation options:

• Full installation on hard drive

• Partial installation on hard drive

• No installation on hard drive (read from CD)
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The installation script performs a full installation. Most sites use a full 
installation for shared access by many users. If disk space is at a 
premium, you can create a partial installation by removing unused 
directories after the installation is complete (see “Partial Installation” 
on page 21-11).

Electronic Software Transfer Installation

To download and install SOLD from the Web or by FTP, follow the 
procedures described in “Downloading and Installing the Software 
by EST” on page 2-2. 

Note:   
To have access to the complete collections of SOLD, download 
all three files. The SOLD files use the following convention:

sold_T-2002.12_common.tar.Z
sold_T-2002.12_ssd1.tar.Z
sold_T-2002.12_ssd2.tar.Z

These files also contain the T-2002.12, T-2002.09, 2002.05, and 
2002.03 documentation.

Example 21-1 shows the SOLD media installation script; it applies to 
installation by EST and from the CD. 

CD Installation

To install SOLD from the CD, follow the installation procedure 
described in “Installing Product Files From a CD” on page 2-6.

Example 21-1 shows the SOLD media installation script; it applies to 
installation by EST and from the CD. Note that the T-2002.12 release 
also contains the T-2002.09, 2002.05, and 2002.03 documentation.
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Untar and uncompress the SOLD files before running install.now.

Example 21-1 Synopsys SOLD Media Installation

Instructions:  The list within {} shows the choices for a given option.
               The entry within [] shows the default selection when you
               hit the Return key.  You can cancel the installation by
               by entering quit when prompted for input.
___________________________________________________________________________

The current mounted Synopsys CD file system is T-2002.12.

        VERSION:     T-2002.12
        PRODUCTS:    ssd jsd 
        PLATFORMS:
        PART NUMBER: XXXXX

___________________________________________________________________________
Install T-2002.12 release? {y,n} [y] y

Enter the full path to the directory where you want to install
Synopsys T-2002.12 products.  If the directory does not exist,
it will be created.  [/usr/synopsys/T-2002.12]: /usr/synopsys/T-2002.12

WARNING: /usr/synopsys/T-2002.12 directory already exists ...
         Any products/platforms that you select for installation
         may overwrite the contents of this directory.

Continue with installation? {y,n} [y] y

Select Synopsys product(s) to install:
        {
        ssd - Synopsys Online Documentation
        jsd - Japanese-language Synopsys Online Documentation
        }
Enter the list of product(s) to install [ssd]: ssd jsd

Product(s) selected: ssd jsd

Please wait, validating installation...

If you continue, you will reinstall (some/all of) the T-2002.12 version of ssd.

Continue with installation? {y,n} [y] y
___________________________________________________________________________
Here is your final selection for installing Synopsys Tools:
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    VERSION:   T-2002.12
    PRODUCTS:  ssd jsd
    PLATFORMS:

   Synopsys Media Directory (from) : /cdrom
   Synopsys Install Directory (to) : /usr/synopsys/T-2002.12

    Platform Independent Package(s) for : ssd jsd

    Disk space required             : 498 MB
    Disk space available            : 55338 MB

If all the information is correct, continue with the installation.
___________________________________________________________________________
Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

Found Acrobat Reader at /usr/local/bin/acroread.
Use this executable to invoke SOLD? {y,n} [y] y

Installing Synopsys Online Documentation ...
Installing dw collection
...
Installing synth collection
Installing Japanese-language Synsopsys Online Documentation ...
Installing jsold collection

Done.

You must now continue with the product-specific installation  procedures,
install the Synopsys keys, and start the license servers.

For more information, refer to /cdrom/README.{ssd jsd} file(s) and
the Installation Guide version T-2002.12.

Thank you ...
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Partial Installation

Because each collection directory is self-contained, partial 
installations of SOLD are possible. 

To effect a partial installation of SOLD, perform a standard 
installation, then delete from $SYNOPSYS/doc/online those 
collection directories you do not need at your site.

Note:   
Do not delete the top.pdf file; it contains the SOLD welcome 
screen. Do not delete the solid directory; it contains the SOLD 
User Guide.

Keep the remaining collection directories intact: Do not remove files 
from them or move the files in a collection relative to each other. 
Such modifications can cause hypertext links and the search 
mechanism to fail.

Verifying the SOLD Installation

Verify the installation by opening SOLD. To open SOLD, issue the 
command

% $SYNOPSYS/sold

If SOLD is correctly installed, this command invokes Acrobat and 
displays the SOLD welcome screen in the Acrobat window.
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Configuring SOLD for Each User

The search engine uses index files to perform full-text search and 
retrieval on a document. SOLD provides an index file (index.pdx) 
with each collection. 

When you open a document, the associated index file is 
automatically available to the search engine. However, to search 
SOLD before opening a document, you can manually make an index 
available to the search engine.

To manually make an index available to the search engine,

1. Choose Edit > Search > Select Indexes in the Acrobat window. 

2. Click the Add button.

3. Navigate to one of the collection directories, for example, 
$SYNOPSYS/doc/online/synth.

4. Select the index.pdx file.

5. With the index.pdx file selected, click the Apply button.

The selected index is added to the list of available indexes.

For information about using SOLD, see the SOLD User Guide. To 
access the SOLD User Guide, open SOLD and click the hypertext 
link labeled “Using Synopsys Online Documentation.”
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Searching SOLD on Linux 

The search plug-in capability for the Linux platform is available with 
version 5.0.5 of Acrobat Reader. If you do not have Acrobat Reader 
version 5.0.5 or later installed, only the Find command (Edit > Find) 
is available for searching the Linux version of SOLD. To locate 
information with the Find command, use the print version of a 
document. On the SOLD front panel, select a document set, then 
click the print version icon ( ) next to the document you want to 
search. 
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Troubleshooting 22

This chapter contains the following sections:

• Memory

• X Window System

• Graphical User Interface Printer Setup
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Memory

Some common memory problems and possible solutions are 
described in this section.

Why Do I Get an “out of memory” Message?

Here is a possible scenario: A large job is running on a machine that 
has abundant swap space. You try to run a Design Compiler job on 
this machine and assume that you don’t need to be concerned about 
running out of swap space. But the application terminates with a fatal 
out-of-memory message before the machine runs out of swap 
space.

UNIX limits the amount of memory a job or process can consume 
while it is running. If a job reaches these limits before the system 
runs out of swap space, the job terminates with the fatal 
out-of-memory error message. These limits are built into the UNIX 
OS to prevent a single job or process from consuming all system 
resources (swap space, CPU time, number of processes, and so on), 
thereby depleting resources for other jobs. Some limits applicable to 
Synopsys applications are

• Data size—The maximum data size (including stack) for the 
process

• CPU time—The maximum CPU seconds per process

• Core dump size—The maximum size of a core dump
22-2

Chapter 22: Troubleshooting



The data-size limit is the most important. It can be set at two levels:

• The system level

Limits are enforced for everyone who runs on that system.

• On a per-user basis

On all machines except those running HP-UX, you can change 
your personal limits by using the limit command (C shell) or  
ulimit -s -d command (Bourne, Korn, or Bash shell). On the 
HP-UX platform, only the system administrator can set the limits. 
Personal limits cannot exceed the systemwide limit. For example, 
the limits on a Sun client (Solaris 7) might look like this:

% limit
cputime          unlimited
filesize         unlimited
datasize         524280 kbytes
stacksize        8192 kbytes
coredumpsize     unlimited
descriptors      256
memorysize       unlimited

Note:   

In this example, any jobs or processes started on the Sun 
client can grow to 524 MB before limits are enforced. 

On some solaris systems, setting the data size  to unlimited 
defaults to a data size of only 2 GB. To set a larger data size, 
set the data size explicitly. For example, set it to 3.8 GB by 
using the following command:

% limit datasize 3891 MB
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If the data size is sufficient, check the stack size. A stack size that is 
larger than the default (8,192 KB) can cause the data size to be 
smaller than required. Because the stack size is taken at the 
beginning of the process, it uses memory that would normally be 
available for data. Therefore you should set the stack size higher 
than the default only when absolutely necessary. 

Most system administrators do not adjust the limits unless they are 
confronted with problems. If you do not adjust the limits, it is possible 
for a tool requiring a lot of swap space (such as Design Compiler) to 
experience an out-of-memory problem.

Note, however, that it is possible to extend memory (physical and 
swap space). For more information, see “Accessing Memory Beyond 
2 GB With 32-Bit Synopsys Tools” on page 1-13.

What Should I Do When an “out of memory” Error 
Occurs?

Make sure that you are not running out of swap space on the system. 
Use the swap -l command for Sun SPARC systems to obtain swap 
space information. For example,

  % swap -l
  swapfile           dev   swaplo  blocks   free
  /dev/dsk/c0t3d0s1  32,25      8  822520   628872

To determine available swap space on systems other than Sun 
SPARC, contact your system administrator. 

If you have enough swap space but still encounter OS limits, use the 
limit command to find out what the datasize variable is set to 
(for all machines except HP). The limit command displays 
user-level limits.
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% limit
cputime          unlimited
filesize         unlimited
datasize         524280 kbytes
stacksize        8192 kbytes
coredumpsize     unlimited
descriptors      256
memorysize       unlimited

If your user-level data-size limit is too low, you can increase it by 
entering limit datasize xxxxm  at the UNIX prompt, where xxxx 
is the number of megabytes and m stands for megabytes. For 
example,

% limit datasize 3891m

Note:   
The limit command is a built-in C shell (csh) command. Make 
sure you are in csh before you execute limit. 

For additional information about the limit command, see the 
appropriate man page. On HP systems you cannot change the 
user-level limits. User-level limits can be changed only at the system 
level.

The procedure for making limit changes varies from platform to 
platform. The system administrator at each site should be familiar 
with the procedure. If you still encounter problems, contact your 
ncuSynopsys technical representative.
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X Window System

Some common X Window System problems and possible solutions 
are the following:

• If you cannot use the vi text editor in the xterm window, add an 
xterm entry in your /etc/termcap file.

• If, after an upgrade, you can no longer open Design Analyzer 
from your host, verify that the fonts assigned in 
.synopsys_dc.setup or the server default fonts are loaded. A fatal 
error results if the fonts are not available.

• Your ~/.xinitrc script might not be read on startup because it is a 
C shell script. In this case, you must rewrite it as a Bourne (/bin/
sh) script.

Graphical User Interface Printer Setup

By default, GUI applications show only one printer in the default 
printer dialog box. The default printer is defined by the PRINTER 
environment variable. To add additional printers to your GUI 
environment, use the snps_addprinter script to specify a printer 
that can be used with Synopsys GUI applications that are based on 
MainWin. For example, from the command line enter 

% cd $SYNOPSYS/platform/mw/bin
% snps_addprinter my_printer1 my_printer2
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Note:   
The snps_addprinter utility works only with GUI applications 
based on MainWin, such as Design Vision, Library Compiler and 
TetraMAX. It does not work with older applications such as 
Design Analyzer or Formality.

If you have other problems with your GUI applications, contact 
Synopsys support. 
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A
Installing FPGA Compiler II (version 
2002.05-FC3.7) on Windows Platforms A

You can install the FPGA Compiler II software to run PC running 
Windows. The procedure is explained in the following sections:

• Product Support

• System Requirements for Windows

• Installing FPGA Compiler II

• Registering FPGA Compiler II

• Enabling Online Document Readers
A-1



Product Support

The FPGA Solutions page on the Synopsys World Wide Web site is 
regularly updated with the latest information. Check this page to find 
application notes, online help updates, and other valuable 
information:

http://www.synopsys.com/products/fpga/

For additional installation instructions, go to

http://www.synopsys.com/products/fpga/install_fc2.htm

System Requirements for Windows

Table A-1 shows the minimum system requirements for installing 
FPGA Compiler II on Windows.

Table A-1 Windows System Requirements

Operating system Memory Disk space for installation

Windows NT 4.0 (Service Pack 
4 or later), Windows 98, 
Windows ME, or Windows 2000

32 MB of RAM

70 MB of swap space1

1. 100 MB of virtual memory (RAM + swap space) is recommended for most designs. Larger designs 
might require more memory.

50–270 MB, depending on file 
system and partition size (50 
MB for NTFS or small FAT 
partition and 270 MB for large 
FAT partition)
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Installing FPGA Compiler II 

You can install FPGA Compiler II on a PC running Windows by 
downloading the tool from the Web or installing it from the CD.

Note:   
Make sure that your licensing software is installed. For 
information on Synopsys Common Licensing (SCL) software, 
see “Acquiring a License” on page 1-15.

To install FPGA Compiler II from the Web, 

• Go to

http://www.synopsys.com/products/fpga/download_fc2.html  

and follow the instructions.

To install FPGA Compiler II from the CD, do the following:

1. Insert the FPGA Compiler II CD into your computer’s CD drive. 

In most cases, the setup program automatically starts. If the 
setup program does not start automatically, run setup.exe from 
the CD directory.

2. Follow the instructions on the screen.

As you move through the installation screens, note the following:

- You can install a subset of the available target devices to save 
disk space. To do this, select Custom in the Setup Type dialog 
box and follow the instructions.
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- The program installation directory path cannot contain space 
characters.

Registering FPGA Compiler II

To register your copy of FPGA Compiler II, fill out the registration 
form included with the software package and fax it to the following 
number:

(650) 584-1747

Registering your new system ensures that you receive technical 
support, warranty coverage, special offers and promotions, and early 
notification of future FPGA products and services.

Enabling Online Document Readers

The FPGA Compiler II User Guide is available online in Portable 
Document Format (PDF). The setup program installs this document 
in the directory where you installed the software. 

To read the Synopsys FPGA online document, you must have Adobe 
Acrobat Reader version 4.0 or later installed on your system. Install 
Acrobat Reader version 4.0 by one of the following methods:

• To install Acrobat Reader on a Windows system from within  
FPGA Compiler II, enter the following command:

CD_ROM_drive:\acrosrch\32bit\setup

• Download the latest Acrobat Reader from the Adobe home page, 
at
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http://www.adobe.com

For more information, see “Downloading Acrobat Reader from 
the Web” on page 21-3.
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